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1.0 INTRODUCTION 
Procedure development is an ongoing process.  Consult the DNA Technical Leader for significant 
changes to any of the following procedures or for developing additional procedures. Proposed changes 
shall be reviewed by those affected by this manual prior to incorporation. Allowances (non-significant 
changes) may be made for adapting procedures (e.g. volume, tube size/type, spin times, incubation 
times) to accommodate unusual samples and situations. Allowances to adapt a standard procedure are a 
recognized part of lab work, as they may be necessary to meet the requirements of certain samples. 
These deviations must be scientifically sound and shall be documented in the case file. 
 
The standard method of analysis of DNA conducted by the Washington State Patrol CODIS Crime 
Laboratory (WSPCCL) for the convicted offender database is by the analysis of Short Tandem Repeat 
(STR) regions by Polymerase Chain Reaction (PCR). The STRs examined by the WSPCCL include 15 
loci, each having a four base pair repeat sequence. These are the 13 core loci selected by Combined 
DNA Index System (CODIS) and the National DNA Index System (NDIS), plus D2S1338 and D19S433. In 
addition, one non-STR locus, Amelogenin is included by the WSPCCL and NDIS. Amelogenin is a sex-
linked locus with two alleles, one located on the X chromosome and one located on the Y chromosome.  
 
PCR is a method used for the amplification of a specific DNA segment whereby two oligonucleotides 
(primers) anneal to opposite strands and flank a DNA region to be copied.  The synthesis reaction is 
repeated for a number of cycles and results in the exponential accumulation of the specified DNA 
segment, the termini of which are defined by the 5’ ends of the primers used in the reaction. 
 
1.1 EXTRACTION 

DNA suitable for PCR-based typing is currently obtained by the Promega DNA IQ™ extraction 
method. 

1.2 HUMAN DNA QUANTITATION 

The Applied Biosystems (AB) Quantifiler™ kits provide reagents and protocols necessary for the 
rapid and sensitive quantitation of human nuclear DNA. The role of the Quantifiler™ Human kit is 
to detect and quantify total human DNA. The genomic targets are PCR amplifiable sequence 
tagged sites on the human telomerase reverse transcriptase (hTERT) locus of chromosome 5. 
The procedure is quantitative PCR (qPCR) and is based on the real-time detection of a 5’ 
fluorescent reporter dye that is cleaved and separated from a 3’ non-fluorescent quencher 
incorporated on a DNA probe during PCR amplification. Also included in the kit is an internal PCR 
control (IPC) consisting of a non-naturally occurring DNA sequence that can detect the presence 
of PCR inhibitors. The qPCR is performed in the AB 7500 Real-Time PCR System instrument. 

1.3 AMPLIFICATION 

The polymerase used, Applied Biosystems AmpliTaq Gold®, requires heat activation. This has the 
advantage that the enzyme is not active during the setup of the samples. The formation of “primer 
dimers” is avoided and there is no time constraint placed upon the setup procedure. To activate 
the enzyme, there is an eleven (11) minute incubation at 95ºC at the beginning of the 
amplification process.  

 
Three steps are involved in each amplification cycle.  First, the template DNA is made single-
stranded by heat denaturation. In the second step, the temperature is lowered so that annealing 
of the oligonucleotide primers to the template may occur.  This interaction is favored because, 
initially, the ratio of primer to template is large.  Annealing of the PCR primers to the template 
DNA is responsible for the technique’s high level of specificity. Under optimized conditions, 
annealing of complimentary DNA strands (primers) should only occur at those sites on the 
template flanking the region to be amplified.  In this way, a sequence of several hundred bases 
can be selected from a background of, in the case of human DNA, 3 x 109 base pairs. In the third 
step, the temperature is raised to a point that favors both specific annealing of the primers and 
extension by the DNA polymerase.  These three steps are repeated over and over again to 
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achieve a sufficient quantity of amplified product.  The target DNA is amplified at an exponential 
rate if one assumes a 100% efficient PCR reaction.  Even when carefully controlled, a PCR 
reaction is rarely, if ever, 100% efficient. 

The AmpliTaq Gold® adds an extra nucleotide (usually adenosine) to the end of a strand of DNA.  
If this reaction only occurs partially, then DNA of two lengths, differing by one base pair, will be 
produced from the same template and primers, causing the appearance of a split peak.  Having 
amplified product of uniform size is important in STR analysis, as it is the length of the final 
product that is detected.  A length variance of one base pair is detectable by the system, and 
therefore undesirable.  To avoid this, the addition can either be prevented or conditions chosen 
so virtually all the amplification product is converted.  Since the latter is easier, a 60-minute soak 
at 60ºC is included at the end of polymerization cycle to drive the addition reaction to completion. 

A kit that contains all of the necessary components to amplify and detect Amelogenin and the 13 
core STR loci used by CODIS is commercially available. It is possible to detect and distinguish 
the products of several loci amplified together. This is referred to as multi-component analysis.  
The detection of all 13 core STR loci plus Amelogenin, D2, and D19 is achieved by the use of the 
Applied Biosystems AmpFℓSTR® Identifiler® kit. 

 
Identifiler® kit loci 

Locus Size Range (b.p.)1 Dye Color2 
D8S1179 128-168 Blue 
D21S11 189-243 Blue 
D7S820 258-294 Blue 
CSF1PO 281-317 Blue 
D3S1358 114-142 Green 

TH01 169-189 Green 
D13S317 206-234 Green 
D16S539 234-274 Green 
D2S1338 307-358 Green 
D19S433 101-135 Yellow 

vWA 157-197 Yellow 
TPOX 218-242 Yellow 

D18S51 273-341 Yellow 
Amelogenin 107, 113 Red 

D5S818 135-171 Red 
FGA 219-267 Red 

 
1This is the size in actual base pairs; the estimated size generated by the CE unit will be different. 
2The dyes used are 6' FAM (Blue), VIC (Green), NED (Yellow), PET (Red) and LIZ (Orange).  For more information on the 
loci and dyes, please see the Identifiler® user's manual. 

1.4 DETECTION 

1.4.1 Multicomponent Analysis 

Multicomponent analysis uses two separate properties to distinguish between loci:  length 
variance and fluorescent labels. 

Length Variance  

The amplified product from each locus will vary in length, dependent upon the number of repeats 
found in a particular STR.  By careful selection of primers, it is possible to produce amplified 
products for several loci, all of which fall into discrete size ranges.  Thus a particular locus can be 
identified by the size of its alleles. 



Washington State Patrol Crime Laboratory Division 
CODIS Lab STR Procedures Manual 

 

CODIS Lab STR Procedures Page 6 of 87 Revision June 1, 2016 
Approved by CLD Commander All Printed Copies Uncontrolled Revision 22 

 

Fluorescent Labels 

Different fluorescent labels can be attached to the primers used in the amplification process.  The 
emission spectra of these labels are sufficiently different such that the contribution made by each 
label in a mixture can be calculated both quantitatively and qualitatively.  Thus, even if two 
separate DNA fragments co-migrate, they can be differentiated by their fluorescent labels. 

By careful selection of both primers and fluorescent dyes, several different co-amplified loci can 
be distinguished based both upon their fluorescence and the size of the fragment lengths. Applied 
Biosystems has constructed the Identifiler®

 kit, which contains five dyes. The green dye covers 
five discrete size ranges, the blue and yellow dyes cover four discrete size ranges each, and red 
covers three discrete ranges, one being a narrow range for the two alleles of Amelogenin. This 
allows for the detection of up to 16 loci at one time. The fifth dye, LIZ, is orange and is used to 
label the internal size standard.  

1.4.2 Applied Biosystems Genetic Analyzers (CEs) 

There are several instruments commercially available that will separate DNA fragments based 
upon their size and fluorescent labels. These instruments separate fragments using capillary 
electrophoresis. A window in the capillary is continually illuminated by a laser. As fragments of 
DNA with fluorescent labels pass by the window, they are excited and the resulting emitted light is 
collected and analyzed.  

The WSPCCL currently uses AB 3500xL Genetic Analyzers. 

1.4.3 Internal Size Standards 

LIZ internal size standard is added to each sample prior to electrophoresis.  The LIZ internal size 
standard consists of several amplified fragments of DNA, all of which have been sequenced and 
are of known length.  The migration time of each fragment is recorded and this data is used to 
calculate an estimated length for the other DNA fragments that are detected. 

1.5 INTERPRETATION OF RESULTS 

The data generated is analyzed using the software program, GeneMapper® ID-X, available from 
Applied Biosystems.   

This program converts the raw data from AB Genetic Analyzers into discrete peaks, assigns a 
size to those peaks based upon their estimated length in base pairs, and converts the estimated 
fragment sizes in base pairs to designated alleles by comparing the fragment sizes to the known 
alleles in a standard called an allelic ladder. The program also displays that data in the form of an 
electropherogram. 
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2.0 CODIS CASE APPROACH 
Quality in the CODIS Laboratory is maintained using the Crime Laboratory Division (CLD) 
Operations Manual, the CLD Quality Manual, the DNA Quality Manual, the DNA Quality 
Assurance Standards, and following the protocols in this STR Analysis Procedures Manual. 
Resources for advice on case approach include senior Forensic Scientists, the CODIS technical 
lead, and the DNA Technical Leader. 

2.1 ADMINISTRATIVE PROCESSING GUIDELINES 

All convicted offender samples received in the laboratory are processed following the guidelines 
of the Administrative Processing of Convicted Offender Samples procedure. Convicted offender 
samples are collected by hundreds of collectors across Washington State using kits provided by 
the CODIS Laboratory. Kits are assembled in-house, and requests for these kits are handled by 
CODIS Laboratory staff. A detailed spreadsheet of kit requests is maintained by CODIS staff. 

Completed kits are received through the mail or hand-delivery. Prior to acceptance by the lab, 
each completed kit is evaluated by a CODIS staff member. Information accompanying the DNA 
sample is assessed for completeness and accuracy. When a question arises about any of the 
submitted information, verification is done using the offender’s criminal history record and/or 
contacting the collecting agency, prosecutor’s office, or other law enforcement entity. Any 
information obtained using these sources is documented on the submission card along with the 
origin of the information and the date and initials of the individual recording the information. If a 
question arises about the quality of a sample, recollection can be requested. An electronic log is 
maintained of all rejected samples.  

Each sample is assigned a unique laboratory number and is referenced only by that number 
thereafter. The electronic Convicted Offender Form is used for data entry into the LIMS system. 
By using the SID of the convicted offender when entering data, the entry program is able to verify 
whether or not a DNA sample has already been received for that individual and will auto-populate 
the electronic entry form with the individual’s name and date of birth. For any sample that is 
determined to be a duplicate, the request generated upon entry of the sample is automatically 
cancelled. Cancelled samples are retained, but are not typically typed unless needed for a hit 
confirmation or as a quality control check. For any sample without a SID, every attempt is made 
to determine if one exists. If one does not exist, the sample is entered manually using an 
acceptable alternative identification number (see the Administrative Processing of Convicted 
Offender Samples procedure for more details). When a non-duplicate sample is entered with a 
SID, the criminal history record of that individual is updated to indicate a sample has been 
received. 

A barcode for each sample is generated once the sample has been entered into LIMS. Barcode 
labels are applied to any individual component of the sample submission. 

Once processed administratively, offender samples are stored in a secure location in the CODIS 
Laboratory until ready to be typed.  

2.2 LABORATORY PROCESSING GUIDELINES 

All laboratory work is conducted following the procedures in this manual and the CLD DNA 
Quality Manual. Any deviation from laboratory procedure is documented in the case file and 
approved by the DNA Technical Leader or designee.  The CODIS technical lead (FS4) is 
designated by the DNA Technical Leader with the authority to approve acceptable minor 
deviations of STR interpretation guidelines and protocols. Before results may be released, peer 
review of a completed file is conducted in accordance with the CLD Quality Manual, this manual, 
and the DNA Quality Manual by a qualified DNA CODIS analyst. 

The date on the top of extraction paperwork is the date the samples were prepared for extraction 
(either robotically or manually). For first-time extractions in manual sets or robotic extractions, this 



Washington State Patrol Crime Laboratory Division 
CODIS Lab STR Procedures Manual 

 

CODIS Lab STR Procedures Page 8 of 87 Revision June 1, 2016 
Approved by CLD Commander All Printed Copies Uncontrolled Revision 22 

 

date is also the date the set was started. The analyst will record the date testing was completed 
prior to technical review on the last page of the case file. 

As a quality control measure, robot sets may contain random reanalysis samples. These are 
known duplicate submissions for existing samples that were previously typed. The goal random 
reanalysis sample amount is five percent of samples per completed samples in a year. Random 
reanalysis samples may also include felon hit confirmation samples. 

GMID-X software is used to record information about samples that pass in a run folder but have 
flags or anomalies. 

The samples are returned to the storage area once the analyst is done working with them. 

2.2.1 Robotic Workflow 

The non-sterile plates and pipette tips employed for robot procedures are UV irradiated prior to 
use.  

Extraction, quantification set-up, normalization of the samples, and amplification set-up all occur 
on the robotic platform. Using the robots requires a minimum amount of analyst involvement.  
There may be occasion when some factor, such as a bubble in the line, affects the accuracy of 
small volume pipetting. If a quantitation result for a sample indicates a below than acceptable 
target concentration, but the sample yields a full profile, the low target does not need to be signed 
off by the DNA Technical Leader or CODIS technical lead. 

Samples are punched into a 96-square well plate using an automated puncher. The barcode is 
read by the puncher computer (if the barcode is unreadable, the laboratory number is hand-
entered into the computer) and associated with a particular well number. The sample maintains 
association with the well number through first analysis on a CE.  A .pdf of the worklist tab of the 
Robot Templates will be generated prior to changing the Extraction Control or Reagent Blank 
values after copying the Puncher worklist into the Robot Templates.  

After the samples have been punched, lysis buffer is added to the plate using a multi-channel 
pipette. The plate is then incubated in a water bath before being placed on a robot. It is 
acceptable to seal a plate after punching if an analyst wishes to wait to extract at a later date. The 
plate should be labeled with the set number, date, and the initials of the analyst. 

During extraction, the analyst waits for the resin to be added by the robot and returns unused 
resin to the “used” resin container. Removing only the disposable trough from the robot deck 
ensures the robot will not pause during the extraction process due to the trough holder no longer 
being present on the robot or not being present in the correct position. Once the DNA in lysis 
buffer has been transferred from the square well plate to the flat bottom plate by the robot, the 
program pauses to allow the analyst to evaluate the flat bottom plate to ensure no punches were 
inadvertently transferred. If a punch is present, it is removed using clean forceps. The analyst 
returns the plate to the appropriate position on the robot and selects “ok” on the screen to indicate 
this check is complete and to re-commence the program. From this point on, the robot requires 
no other human interaction during the extraction process. 

All other manual interactions with robot plates are handled at the robotic workstations. 

The liquid in the wells of the elution plate that will contain the quantification standards and 
controls is removed; this ensures the quant standards and amplification controls will not be 
diluted unnecessarily. 

During quantification setup, quantification standards are manually added to the quant plate in an 
appropriate hood. The positive amplification controls are also added in an appropriate hood 
during amplification setup. The negative amplification control is added at the robotic workstation 
using the TE buffer that was used for normalization. 

For any sample that requires manual manipulation from a robot plate to another plate or tube, a 
witness is required only if no genetic information is present in the first pass data. The witness 
initials and dates the steps that were observed on the appropriate worksheet(s).  
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A CODIS analyst assigns the samples to themselves as a work list in LIMS prior to administrative 
review. A bar code for the work list is generated by LIMS and printing the first page of the work 
list.  A mass-marking program allows the analyst to scan or enter their work list barcode, assign a 
set number to each of the samples, enter a result to Findings Entered, and indicate their technical 
and administrative reviewers. After the program is run, each of the samples in the work list will 
have this data associated with it and be marked “Admin Reviewed” in LIMS. At this point, the 
criminal history record, for those samples with SID numbers, is updated to indicate the DNA 
sample has been typed for each of these samples. 

2.2.2 Manual Workflow 

Rather than constructing a work list for a manual sample set, the analyst may individually assign 
the samples to themselves in LIMS. When analysis is complete, they add a result to the Findings 
section and mark the sample Draft Complete. Additionally, the set number the sample was typed 
in is indicated in the Notes field of the Case Info tab. The technical reviewer individually marks 
each sample “Tech Review” and the administrative reviewer individually marks each sample 
“Admin Review”. 

All tubes used in manual lab work are run in an autoclave and subsequently UV irradiated. 

Each DNA sample is evaluated when determining how much to take for extraction. For blood 
samples, 3 Harris punches is common. For buccal samples, evaluation of the FTA paper for an 
appropriate color change is conducted. If there was a good color change on the paper, 5 Harris 
punches is common. If a sample exhibits little to no color change or the FTA paper does not 
appear disturbed, it is appropriate to take a cutting. For larger quantities of sample taken, a larger 
volume of lysis buffer is required. The reagent blank should contain the same volume of lysis 
buffer as the sample that had the most buffer. 

If all of a sample is consumed, “sample consumed” along with the date and analyst’s initials is 
written on the outside of the sample envelope.  

The reagent blank and negative amplification control are amplified at the maximum volume 
allowed for the amplification. At minimum, the maximum volume taken for a DNA sample is used 
for the reagent blank. 

When labeling tubes for amplification, the analyst will do so either behind a shield, with a mask, or 
in a hood to prevent contaminating the tubes with their own DNA. 

2.2.3 Guidelines for Microcon® 

In instances where multiple extractions have produced weak results, the extractions may be 
combined in a microcon to concentrate the DNA.  

When the Quantifiler™ IPC is inhibited for a sample, or the sample appears degraded in the 
genotype results, the sample may also be microconned (even if only one extraction had been 
conducted up to that point). 

When using a microcon, the associated reagent blanks for individual extractions are microconned 
at the same time. The date of the microconned reagent blank is the date the microcon was 
conducted. 

2.2.4 Data Analysis 

Ladders and controls are evaluated before conducting data analysis of convicted offender 
samples.   

When anomalies are observed in the genotyping results of a sample they are verified/confirmed 
following the guidelines in the Guidelines for Evaluating Convicted Offender DNA Typing Profiles 
Using GeneMapper® ID-X protocol.   
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2.2.5 Alleles Below Reporting Threshold 

Alleles below threshold may not be reported for entry into CODIS. Refer to the CODIS SOP for 
minimum number of allele requirements for convicted offender samples.  A manual CODIS table 
is generated for samples that are not NDIS eligible or are missing D2 and/or D19 following the 
requirements listed in section 28.7 CODIS Database of this manual.  

If an incomplete profile is generated for a hit confirmation, the resulting alleles may be reported 
for exclusionary purposes even if there is fewer than the allowable minimum number of loci. 

2.2.6 Microvariants and Tri-alleles 

Careful evaluation of potential microvariants and tri-alleles is conducted by the CODIS analyst. In 
some instances, particularly with locus D2S1338, a microvariant allele for a locus extends into a 
neighboring locus. In instances where a locus is a homozygote and the neighboring locus is a tri-
allele, peak heights are considered to verify if one of the alleles in the tri-allele might actually be a 
second allele for the homozygous locus. STRBase is also consulted for previously reported tri-
alleles at a particular locus.  

If an extreme peak imbalance (less than 45%) is noted for a heterozygous locus that is adjacent 
to a homozygous locus, care is taken to see if one of the alleles might be associated with the 
homozygous locus. When confirming the peak imbalance in this scenario, it may be necessary to 
amplify the sample in a full volume reaction. 

A reinjection of a sample suspected of being a microvariant or tri-allele may be performed to 
verify the anomaly (see 30.1.2.iii, in this manual, for a detailed description of when re-injection is 
necessary). STRBase is consulted to determine if the microvariant or tri-allele had been 
previously reported. To serve as a confirmation, the microvariant or tri-allele should be reported 
using a CE platform and the Identifiler™ amplification kit.  If the microvariant or tri-allele had not 
been previously reported under these conditions, a re-extraction is performed. If the same 
genotype results with re-extraction, the microvariant or tri-allele is reported in the file. After peer 
review, the not-previously-reported microvariant or tri-allele is submitted to STRBase.  

2.2.7 Contamination 

In instances of a suspected contamination event where the questioned PCR product is above 
analytical threshold, troubleshooting is done to determine where in the laboratory process it may 
have occurred. The CODIS contamination flowcharts in the DNA Quality Assurance Manual are 
consulted to assist with troubleshooting. Reanalysis of samples or controls containing suspected 
contamination below analytical threshold is not required. The procedure for evaluating 
contamination using the CODIS database is outlined in the CLD CODIS Manual. Contamination 
events above analytical threshold will be documented in the CODIS Contamination Log. 
Contamination should be reported to the CODIS technical lead as soon as possible. 

2.2.8 Failed Samples 

If a full profile is not generated for a sample after consuming the entire sample, the sample is 
considered to have failed. The request is cancelled in LIMS. A note about the sample failing or 
being SDIS-only is entered into the Notes field of the Case Info tab. If a duplicate is available that 
has not been typed, the analyst will un-cancel the request and type the duplicate sample at their 
next available opportunity. If the sample does not have a duplicate, the flags are changed to 
reflect a “no” result for the DNA Taken and Typed fields.  The collecting agency or other law 
enforcement entity is contacted to see if the individual is still incarcerated to recollect the sample.  
Whether or not a sample can be recollected and the source of the information is documented on 
the Run Folder Review worksheet. When an agency agrees to recollect a sample, the information 
is recorded on an electronic log for recollection requests. It is the responsibility of the individual 
requesting sample recollection to follow up with an agency to ensure recollection occurred. 
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2.2.9 Composite Profiles 

In instances where a sample has been consumed and a full profile was not developed, but a 
more complete or full profile may be constructed by considering multiple results of that sample, 
those iterations may be used to generate a composite profile. For a locus to be considered for 
use in the composite profile, it must meet reporting requirements as described in this manual.  

A manual table is generated following the requirements listed in section 28.7 CODIS Database of 
this manual. All run folders used for the composite profile will be indicated on the Run Folder 
Review sheet. 
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3.0 QUALITY ASSURANCE/QUALITY CONTROL 
3.1 DNA ISOLATION AREAS 

1. All solutions used in DNA isolation are prepared according to the protocols in the 
Reagent Preparation section of this manual. 

2. All glassware to be used in preparation of critical reagents will be autoclaved.  If a 
solution itself is to be autoclaved, the glassware used in its preparation need not be 
autoclaved beforehand.  Pipette tips and microcentrifuge tubes that are sterilized (as 
in the manufacturing process) need not be autoclaved. 

3. Gloves will be worn where appropriate.  

4. Instruments used to cut or handle stains (scissors, forceps, scalpels, Harris punch) 
should be cleaned before each use.   

5. Use filtered pipette tips when pipetting any solutions.  

6. Care should be exercised when inserting pipettes into reagent containers.  Stock 
reagents should be poured from the reagent bottle into a smaller container from 
which pipetting should be done.  Avoid touching the container with the barrel of the 
pipette.  

7. The work area should be cleaned after each use with 10% bleach or other 
appropriate cleaner. 

8. The interiors of microcentrifuges should be cleaned periodically. 

3.2 PCR SET-UP AREA 

1. Gloves will be worn when working in the PCR set-up hood. 

2. Set up the PCRs according to protocol.  Use only the pipettes dedicated to the PCR 
set-up area.  Use sterile, filtered pipette tips.  Dispose of pipette tips in a waste 
container in the hood.  

3. The hood will be cleaned on a regular basis with a 10% bleach solution (or other 
appropriate cleaner) and then rinsed with water (if using bleach).  Pipette barrels will 
also be wiped regularly with a 10% bleach solution (or other appropriate cleaner). 
Additionally, the UV light in the hood (if so equipped) will be utilized after each use of 
the hood. 

3.3 AMPLIFICATION AND PRODUCT ANALYSIS AREA 

1. All solutions used in the amplification and product analysis area are prepared 
according to the reagent manual protocol. 

2. Gloves will be worn where appropriate when working in the amplification room. 

3. Only dedicated lab coats will be worn when working in this area. 

4. Handling of PCR products will be done with dedicated pipettes and filtered pipette 
tips. 

5. If bench top protective paper is used, it will be changed at least weekly.  

6. Any PCR product or other items contaminated with PCR product will be discarded in 
the appropriate container in the PCR amplification/analysis work area. 

7. PCR product may only be stored in a dedicated refrigerator or freezer.  
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3.4 CONTROLS AND STANDARDS 

3.4.1 Reagent Blank 

A reagent blank will be prepared each time a set of DNA samples is extracted.  The reagent blank 
will be prepared like the other samples being extracted, except no source of DNA will be added to 
this sample. Any generated reagent blank shall be amplified using the same primers, instrument 
model, and concentration conditions as required by the sample(s) containing the least amount of 
DNA. The amplified reagent blank shall be typed using the same instrument model, injection 
conditions, and most sensitive volume conditions of the extraction set. 

In accordance with FBI QAS Standard 9.5.3.2, if multiple reagent blanks are used within an 
extraction set, each reagent blank shall be quantified and at least one shall be amplified if any of 
the specimens associated with the extraction set will be amplified. If multiple reagent blanks are 
used and quantified with an extraction set, at minimum, the reagent blank that demonstrates the 
greatest signal, if any, shall be amplified and characterized.  

When concentrating samples where a single extraction generated multiple reagent blanks, only 
one of those reagent blanks is required. The reagent blank taken forward should be one that, if 
formerly quantified, demonstrated the greatest signal, if any, unless that reagent blank was 
already demonstrated to be contaminated.     

If the reagent blank associated with the extraction set or sample being amplified is depleted, an 
analyst shall not continue. The volume of sample amplified cannot exceed that of its reagent 
blank.   

3.4.2 Positive Extraction Control 

The positive extraction control is a sample from a known individual within the laboratory system 
who does not work in the CODIS Laboratory.  Ideally, this control is run with every extraction 
through data analysis and should be treated as a regular sample.  Every attempt should be made 
to get the positive extraction control to successfully genotype, but if it is the only sample delaying 
the completion of a set, testing may cease with an explanation provided in the case file. 

Should a positive amplification control fail, a positive extraction control that is run in the same 
amplification may be used in its place to demonstrate the amplification worked as expected. 

3.4.3 Positive and Negative Amplification Controls 

At the amplification step, two extra tubes containing the amplification master mix will be prepared.  
To one tube the appropriate volume of extracted positive control DNA 9947A will be added, and 
to the other an equal volume of TE will be added.  

A positive and negative amplification control will be included in every set of amplifications 
conducted.  

3.4.4 Internal Size Standards 

An appropriate internal size standard will be included with every sample prepared to be run on 
the CE. The data collected from this standard will be used to verify the quality of a particular 
injection and also be used to estimate the size of any DNA fragments present in the run. It is 
essential to have the data from this standard in order to process samples in the GeneMapper® ID-
X program. 

3.4.5 Allelic Ladder 

An appropriate ladder will be included with every injection on the CE.  A passing allelic ladder is 
essential in order to process samples in the GeneMapper® ID-X program. 
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3.5 QUALITY CONTROL OF REAGENTS 

The following critical reagents shall be evaluated prior to use: 

1. Promega DNA IQ kit 

2. Dithiothreitol 

3. TE 

4. Quantifiler kit 

5. Promega G147A for the QF standard curve 

6. AmpFℓSTR® Identifiler kit 

 

3.6 REAGENT QUALITY CONTROL TESTING  

Unless a quality control procedure indicates otherwise, a known DNA sample is used to perform the QC 
of a new lot number of reagent or kit before it may be used on convicted offender samples. The known 
DNA sample must be analyzed using the current laboratory protocols. The known DNA sample must type 
correctly and meet all data analysis parameters as required in the current laboratory protocols. If the 
sample does not type correctly or does not meet the analysis parameters, the reagent or kit may not be 
used for convicted offender analysis until the problem is resolved. Scientifically valid exceptions 
pertaining to meeting the analysis parameters can be made if approved by the CODIS technical lead in 
consultation with the DNA Technical Leader. The successful completion of the QC is documented on the 
reagent or kit and on the appropriate QC worksheet. All QC testing will be verified by another CODIS 
scientist to ensure that analysis parameters are met, the paperwork is filled out correctly, and the 
electronic data is present. This verification will be documented on the QC worksheet, which will then be 
saved as a PDF and stored with the electronic data. 
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4.0 PERFORMANCE CHECK AND CALIBRATION OF INSTRUMENTS 
Routine maintenance procedures are described by instrument/equipment elsewhere in this 
manual (see Table of Contents). A maintenance item does not necessarily have to be performed 
on-schedule for an instrument that isn’t being used at the time the maintenance is due. The 
operator will ensure all necessary maintenance items are performed prior to use.  If annual 
maintenance is required of an instrument, it is not necessary to perform it within the year if the 
instrument is taken off-line. 

The performance check and/or calibration of instruments demonstrate they are working properly 
and will produce the expected results.  Performance checks will be conducted at least annually, 
and for critical instruments after calibration, maintenance, or repair.  Specific performance check 
and/or calibration procedures may be found in the Instrument Maintenance log for that instrument 
(and in the Instrument Maintenance sections of this procedure manual).  Written documentation 
of calibrations and performance checks will be maintained. 

For each refrigerator/freezer/oven/water bath/heat block, variance should be established as per 
the Equipment Calibration and Maintenance section of the DNA Analysis Quality Assurance 
manual.  If, when the temperature is checked, the equipment is functioning outside that range, 
use of the equipment in forensic testing should be stopped immediately and measures taken to 
return the equipment to function within its accepted range.   

1. pH meters will be calibrated with known pH standards according to the 
manufacturers' instructions before they are used.   

2. Balances will be checked at least annually by an external provider.  

3. The operating temperature of refrigerators, freezers, and any other storage unit or 
area used to store reagents or samples that would degrade if not maintained at or 
below a given temperature will be recorded each working day or monitored using the 
TempGenius system.  

The operating temperature of ovens, water baths, or other apparatus that is used to 
maintain a constant temperature of reagents or a reaction should be checked each 
working day, prior to its use, or monitored using the TempGenius system. 

Semiannually, the thermometers/probes used to record these temperatures will be 
verified against a NIST traceable thermometer. The thermometer/probe can remain in 
service if it is within ± 4° C of the NIST traceable thermometer. Alternatively, a 
thermometer can be used that is NIST traceable and certified for a specific time 
period as long as it is replaced or re-certified before that period has expired. 

4. NIST traceable thermometers will be re-certified annually by an appropriately 
qualified external agency. 

5. Thermal cyclers are a critical instrument and will be performance checked semi-
annually using the appropriate temperature probe and the directions provided by the 
manufacturer of the thermal cycler. 

6. Annually, the probes used to check the calibration of thermal cyclers will be re-
certified by an appropriately qualified external agency. 

7. Pipettes will have their calibration checked annually by a qualified external agency. 

8. The AB genetic analyzers are critical instruments.  They are subject to annual 
maintenance by a qualified technician.   

An instrument verification shall be performed on a CE unit prior to use on convicted 
offender analysis for a CE unit that is moved or when a technician provides repair or 
routine maintenance. This verification will consist of successfully running an 
amplification positive or other known sample, an amplification negative, and a ladder 

http://sharepoint/sites/flsb1/CLD/DNA/Manuals/DNA_QA_Manual_Rev_20.pdf
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on the instrument and, if the sensitivity may have been affected, the HID install 
standard performance check.  Verify the sample genotyped correctly and meets all 
data analysis parameters as required in the current laboratory protocols. 
Documentation of this verification will be maintained by the laboratory.  

A new instrument requires a performance check which includes: 1) an instrument 
verification, 2) a sensitivity check, and 3) a 1 base pair precision check (± 0.5) with a 
minimum of data from 6 ladders run per capillary.  

Data from a performance check of a new CE instrument will be compared to the other        
instruments in the laboratory. Requests for approval of new CE instruments for DNA 
analysis will include the performance test results, precision testing results, and 
demonstration that the sensitivity is in the CODIS Laboratory’s established range.   

A new spatial shall be run if a repair/maintenance involved removing the capillary 
array from the detector, if the capillary is changed, or if the instrument is moved. 

9. The AB 7500 Real-Time PCR System is a critical instrument with a monthly 
calibration check and semi-annual calibration following the manufacturer’s 
instructions. Additionally, the 7500 is subject to an annual maintenance by a qualified 
technician.  

10. The QIAGEN BioRobot® Universal is a critical instrument. Monthly and semiannual 
performance check/calibration programs shall be run according to manufacturer 
instructions. Additionally, annual maintenance is conducted by a qualified technician. 

5.0 PROCESSING OF CONVICTED OFFENDER SAMPLES 
DNA samples received by the CODIS Laboratory are treated as reference materials.  

Buccal samples on FTA paper (from a WSP provided kit) from convicted offenders are collected and 
submitted to the Crime Laboratory by law enforcement facilities.  In rare instances, blood samples are 
drawn instead. It has been requested that these samples be submitted in EDTA vacutainer tubes, 
accompanied by a Washington State Patrol Crime Laboratory Division Convicted Offender DNA Data 
Sheet (WSP-CL-549).  

On receipt, each whole blood sample is prepared as follows: 

1. Ten to twelve 75 µl stains are prepared on Schleicher & Schuell 903 paper or other 
clean filter paper.  The stains are air-dried, sealed in plastic bags, and frozen at         
–20°C to –80°C, pending analysis. 

2. Any remaining whole blood is destroyed by pouring into a disinfectant solution.  The 
destruction of each blood sample is witnessed. 

DNA typing of the convicted offender blood samples is done using a portion of one of the prepared 75 
µl bloodstains.  Similarly, DNA typing of convicted offender buccal samples is done using a portion of 
the submitted FTA card. 
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6.0 WALLAC DBS PUNCHER PROTOCOL – ELECTRONIC BARCODE 
RECORD TRACKING 

This protocol is for taking punches from buccal samples on FTA® paper and blood stains on S&S filter 
paper typically provided as samples from convicted offenders when an electronic record of the 
barcode/lab numbers is used as the tracking record.    

6.1 STARTING THE WALLAC DBS PUNCHER SOFTWARE PROGRAM: 

1. Turn on the computer. 

2. Double-click the “Wallac DBS Puncher” icon to open the software program. 

3. From the program menu, select “Tools > User Level”.  

a. Select the User Level of “Advanced”.  
b. Enter the password.  
c. Click “OK” to close User Level window. 

6.2 CREATING A NEW PUNCHING PROTOCOL:  

A protocol serves as a template. It is ideal to have a few protocols pre-established rather than 
creating a new protocol for each set of samples. 

1. Select Tools > Protocol Editor.  

a. With the General tab selected, click New. 

b. Fill in the following information: 

 Protocol name: A unique name to identify the protocol.  i.
 Max number of plates: 1 ii.
 Punch head size: 4.7 mm (3/16”) iii.
 Position of 1st plate: Right iv.
 Place a check-mark in Twin plate protocol field. v.
 Punches to each well: in the first window, enter the number of vi.

punches that will go into the sample plate (plate on the RIGHT). In 
the second window, enter the number of punches that will go into the 
waste plate (plate on the LEFT) - this value may be 1 even if more 
punches are selected for the sample plate.  

 Patient replicates: 1 vii.
 Leave the Read plate barcodes field unchecked. viii.

2. Select the Plate Maps tab: 

a. Plate Number and Plate Map Type should be left as the defaults: 1 and 
Independent, respectively.     

b. Highlight each well (or wells) and designate them as one of the following: 
Extraction Control, Empty, Reagent Blank, or Sample. 

3. Select the Worklists tab and set up as follows: 

a. Worklist file type: Simple 

b. Worklist file path: C:\DATA 

c. Worklist file name: This is the electronic name of the output file. Use the set 
name.  

d. Printout type:  None 
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e. Leave the last four fields (for the waste plate) as the defaults: <none>, blank, 
blank, and <none>, respectively. 

f. Click OK 

6.3 PUNCHING: 

1. Clean the puncher head 

a.  Remove the trigger plate and wipe it with a soft cloth or Kimwipe® tissue 
moistened with detergent. 

b. Remove the semi-circular cover plate, press the spring-loaded button, and pull 
out the puncher head.  (Note:  the puncher piston will fall out of the puncher 
head if turned upside down during handling.) 

c. Clean the puncher head with a brush or a jet of high pressure air. 

d. To replace the puncher head, push in the spring-loaded button and make sure 
the narrow part of the rubber ring on top of the head engages with the metal 
fork that lifts the piston.  Push the head back until it is firmly in position and 
release the button. 

2. Turn on the puncher by using the switch on the top-right back-side of the instrument. 
The instrument will perform an automatic check of its functions. 

a. Once on, the puncher asks whether it will be used in a procedure controlled 
by external control software (Slave, TTY) or as a Stand Alone puncher (S/A). 

b. Select Slave mode and the screen should read “Under external control”. 

3. Run a static ionizer unit over and under the trigger plate and over the 96-well plate 
and then place it near the punching area. 

4. From the main screen, start the protocol by doing the following: 

a. Select the desired protocol from the Select “Protocol” field.  

b. Change the name of the worklist to the set number. 

c. The Worklist mode should be designated as “Start new”. 

d. Click the “Start Punching” button. 

e. Follow the prompts on the computer screen and load the sample plate on 
the RIGHT side of the DBS Puncher oriented so A1 is in the back right of 
the puncher and press OK on the puncher screen. 

f. Load the waste plate on the LEFT side of the DBS Puncher oriented so A1 
is in the back right and press “OK” on the puncher screen. 

g. The DBS Puncher will calibrate and position itself over the first well to be 
punched. 

5. Start punching:  

a. Turn the barcode reader on by pushing the button on the top and scan the 
barcode of the first sample by presenting it to the barcode reader and waiting 
for the beep. 
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b. Alternatively, if the barcode cannot be read, the number may be manually 
entered.  Type the number including the dash and press enter 

c. When the sample number has been successfully read, place the sample 
under the punch head. 

d. Instruct the instrument to punch by doing one of the following: 

 Select “Punch” on the DBS Puncher screen or i.

 Gently press down on the trigger plate below the puncher head or ii.

 Press the foot pedal iii.

e. When one punch has been punched, the instrument will indicate that it is 
ready to punch an additional punch into the well from the sample (if the 
protocol indicates multiple punches) or will move to the waste plate for a 
cleaning punch.  

f. Once the waste plate is under the punching area, use compressed air to 
clean the punch stand of any debris. Use clean filter paper for the cleaning 
punch between each sample. 

g. The puncher will automatically move the plate to the next sample well and 
will prompt the user to read the next barcode. 

h. To check the plate mid-program, click “Check Plate” to bring the plate to the 
loading position.  The plate may be removed and visually checked to assure 
that everything is correct. Return the plate to the proper position and use the 
“Resume” softkey to continue punching.   

6. When all samples have been punched as designated on the sample sheet: 

a. Click the “Plate Completed” button on the computer screen. 

b. Follow the prompts on the computer screen. 

c. Click “OK” once the computer screen indicates  “You have punched all the 
plates to this worklist.” 

d. The worklist is saved to the Data folder on the computer and is used as the 
sample tracking record. 

7. When the punching session is over, turn the puncher off using the switch on the back 
of the instrument. 
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7.0 DNA IQ™ MANUAL EXTRACTION FOR CONVICTED OFFENDER 
SAMPLES 

This method is for DNA extraction from buccal samples on FTA® paper and blood stains on filter paper 
typically provided as samples from convicted offenders. This method may also be used for swabs, 
foam-applicators, and gauze or other cloth materials.  The DNA IQ™ extraction system (Promega) is a 
DNA extraction method that uses a paramagnetic resin to capture DNA.  Provided there is sufficient 
DNA present to saturate the resin, elution into 100 µL will give a concentration of approximately 1 
ng/µl. A range of elution volumes can be used to vary the concentration of the resulting DNA extract. 
Depending on the nature of the sample being extracted, the elution volume or the amount of sample 
extracted can be adjusted.     

1. Place sample into a 2 mL tube basket assembly or, for smaller sample sizes, a 1.7mL 
microcentrifuge tube (or other tube/tube basket assembly that has been performance 
tested and found to be suitable). 

2. Add 150 µL (or up to 300 µL for larger sample amounts) prepared Lysis Buffer +DTT 
and incubate at 95°C for 30 minutes. 

3. Using a sterile technique, remove any punches from the tubes. If using a tube/basket 
assembly, transfer sample into the basket insert and place the insert back into the 
tube. Spin at maximum speed in a microcentrifuge for 2 minutes. Remove and 
discard the basket insert, including the basket contents. 

4. Vortex stock resin bottle for 10 seconds. Add 3-7 µL re-suspended resin to sample. 
Keep stock resin re-suspended while dispensing to obtain uniform results. Vortex 
sample tube for 3 seconds and incubate at room temperature for 5 minutes. 

5. Vortex sample tube for 2 seconds. Place sample tube on magnetic stand and 
carefully discard solution with a disposable pipette without disturbing resin. 

6. Add 100 µL prepared Lysis Buffer +DTT and vortex tube for 2 seconds. Place tube in 
magnetic stand. Carefully remove and discard solution. 

7. Add 100 µL prepared 1X Wash Buffer to tube and vortex for 2 seconds. Place tube in 
magnetic stand and carefully discard solution. Repeat for a total of three washes. 

8. With lids open, air-dry 5-20 minutes at room temperature on the magnetic stand. 

9. Add Elution Buffer (between 25 and 100 µL; usually 50 µL) and close lids. Vortex 
tube for 2 seconds and incubate at 65°C for 5 minutes. 

10. Remove tubes from heat, immediately vortex for 2 seconds and place on magnetic 
stand. Remove DNA extract to a microcentrifuge tube for immediate use and/or 
storage. Samples may be stored in a refrigerator for a few days or in a freezer for 
long term storage. 



Washington State Patrol Crime Laboratory Division 
CODIS Lab STR Procedures Manual 

 

CODIS Lab STR Procedures Page 21 of 87 Revision June 1, 2016 
Approved by CLD Commander All Printed Copies Uncontrolled Revision 22 

 

8.0 QIAGEN BIOROBOT® UNIVERSAL -- INTRODUCTION 

The QIAGEN BioRobot® Universal with QIAsoftTM v 5.0 software is used by the Washington State 
Patrol Crime Laboratory Division CODIS Laboratory to extract DNA, set up quantitation reactions, 
normalize the concentrations of the DNA, and set up the STR amplification reactions for convicted 
offender samples. The layout of the instrument work surface is designated numerically starting from 
the back of the instrument to the front in columns from left to right. There are six columns of five 
locations each. Location one in the back left is where the tips are ejected. Figure 1 illustrates this 
numbering system. 

Figure 1: Numbering system on the Universal 
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The BioRobot Universal employs software (QIAsoft™) to manage the robot and allow development 
and execution of each protocol.  There are five protocol environments that are accessible by users 
based on their user level.  For more information on these environments, see the QIAsoft™ Operating 
System Users Manual. 

The Maintenance Environment should be checked before each run to see if a maintenance procedure 
should be performed. 

Tip ejector 
and probe 

wash 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

Heat 
transfer 
adapter  

15 

16 

Vacuum 
Base 

17 

 
 

Shaker 
18, 19, 23, 24 

20 

21 

Vacuum 
Manifold 

22 

25 

26 

27 

30 
 

2 

D
ispenser 
H

ead 



Washington State Patrol Crime Laboratory Division 
CODIS Lab STR Procedures Manual 

 

CODIS Lab STR Procedures Page 22 of 87 Revision June 1, 2016 
Approved by CLD Commander All Printed Copies Uncontrolled Revision 22 

 

9.0 QIAGEN BIOROBOT® UNIVERSAL -- PREPARATION OF SAMPLES 
FOR DNA IQ™ EXTRACTION  

9.1 PREPARATION OF SAMPLES 

1. Take punches from each sample, distributing them into a deep 96-well plate using 
the DBS Puncher. The size of the punch and number of punches taken are at the 
discretion of the scientist, but if using the 4.7 mm punch, no more than four punches 
should be taken per sample.  Follow the procedure in this manual for operation of the 
DBS Puncher. 

2. Add 150 µL of Lysis Buffer + DTT to each well (including controls) of the deep well 
plate, seal the plate with sealing foil, and incubate for 30 minutes at 95ºC. Continue 
with BioRobot® DNA IQ™ Extraction Protocol. 
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10.0 QIAGEN BIOROBOT® UNIVERSAL – DNA EXTRACTION SETUP  
1. Turn on the BioRobot® and start the QIAsoft™ Software. 

a. Enter the username and password. 

b. Open the “DNA IQ” protocol.  

c. Click on the green arrow to start the program. 

2. Start the program from the beginning and follow the instructions as given by the 
program.  Default values are typical for this process: 

a. Enter sample number – enter the sample number. Follow the instructions for 
placing racks on the robot.  

b. Enter the volume of Lysis Buffer to be added in the second step.  

c. Enter the volume of Wash Buffer to be added. 

d. Enter the volume of Elution Buffer to be added – The acceptable range for 
the robot is 50 – 100 µL. 

e. Place the elution rack in the appropriate location, remove the tape and leave 
the lid on. 

f. Vortex the Resin and then fill the 20 mL trough with at least 5 mL. Be sure 
to vortex the resin well before manually pipetting into the trough. Use the 
resin in the resin bottle marked “reused”. If there is not enough, then add 
resin from a stock resin bottle of the same lot. 

g. Put the 5 x 80 mL troughs in the trough holders. 

h. The robot calculates the amount of reagents to put in each trough. It is 
acceptable to round up to the nearest 5 mL when putting the reagents in the 
troughs. 

i. Fill the tip racks as described. 

3. The robot will initialize and then begin extraction. During the extraction process: 

a. Wait for the robot to finish dispensing the Resin and move the Reagent Tray 
to the heat plate. 

b. Remove the trough, leaving the Reagent Tray in place and manually pipette 
remaining resin to the resin bottle marked “reused”. 

c. The robot will pause after transferring the Lysis Buffer from the deep well 
plate to the flat bottom plate to allow the analyst to verify no sample 
punches were transferred into the flat bottom plate. Once the scientist has 
verified no punches were transferred, select OK on the computer screen to 
continue with extraction. If punches were transferred, remove them with 
clean forceps ensuring the forceps are cleaned between uses. 

d. At this time it is acceptable to leave the robot running unattended; however 
it is recommended to periodically check on the run. 

e. Once extraction is complete, discard the deep-well extraction plate and flat 
bottom plate and preserve any remaining buffers by covering the troughs 
with parafilm until the next use. 

f. The samples can remain on the robot for quantitation setup. 

g. If the samples will not be immediately used, put the lid on the plate and 
store in a refrigerator. 
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h. Store the plate in a freezer with strip caps for long-term storage. 
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11.0 QIAGEN BIOROBOT® UNIVERSAL – QUANTIFILER SETUP  
Prior to setting up the ABI Quantifiler™ Human kit with the QIAGEN BioRobot® Universal, turn on the 
ABI 7500 Sequence Detection System (SDS) and associated computer.  

1. Prepare the standard curve according to the instructions in this manual (Reagent 
Preparation section). 

2. Prepare the Quantifiler™ PCR reaction mix in a tube using the following calculation: 

Reaction mix: (# samples + standards) x 5.2 µL 

Primer: (# samples + standards) x 4.4 µL 

a. Be sure to vortex and spin the primer prior to dispensing and swirl the 
reaction mix prior to dispensing.  

b. Vortex tube after combining reagents. 

3. Turn on the BioRobot® Universal and associated computer and open the QIAsoft™ 
Software. 

c. Login to the software. 

4. Open the appropriate quantification setup protocol. Follow the directions given by the 
robot: 

a. Enter the sample number  

b. Place the plates on the robot in their appropriate location and remove the lid 
from the elution tube rack. 

c. When placing the optical plate on the robot, do not touch the tube portion or 
top of the optical plate, even with a gloved hand. 

d. Enter the volume of Master Mix to be added per well – for a 10 µL 
quantitation, the default is 9 µL. 

e. Place the tube with Master Mix on the cooling block, remove the lid. 

f. Enter the volume of DNA to be added per well – for a 10 µL quantitation, the 
default is 1 µL. 

g. Fill the tip racks as described. 

5. Once the program is complete, set the optical plate into the optical plate holder. Be 
careful to not set the plate directly onto the lab bench. 

6. Complete the Quantifiler™ set up as follows:  

a. In a PCR prep hood, manually add the standards to the appropriate wells in 
the plate. 

b. Cover the plate with optical adhesive film and use the plastic wedge to seal 
the plate; ensure no air bubbles are on the seal. Do not touch the top of the 
seal (even with a gloved hand). 

c. If air bubbles are present, flick the plate to remove them (do not touch the 
tube or top part of the plate) or place plate and plate holder into the 
centrifuge and spin at 3000 - 3100 rpm for one minute. 

d. Evaluate the plate to be sure there are no bubbles in the wells. If any 
remain, flick the plate and/or spin again until the bubbles are gone. 

e. Push open the ABI 7500 SDS plate tray  
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f. Place the 96 well plate in the ABI 7500 SDS instrument with well A1 in 
upper left corner.   

g. Push the tray closed. 

h. Follow the Quantifiler™ and ABI 7500 SDS Instrument Data Analysis and 
Interpretation SOP for collecting and analyzing data. 

7. Turn off the ABI 7500 SDS instrument at the earliest convenience.  
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12.0 QIAGEN BIOROBOT® UNIVERSAL – NORMALIZATION OF 
QUANTIFIED DNA 

1. Convert the Quantifiler™ Human DNA results from the 7500 SDS instrument into an 
exportable file for the QIAsoft™ operating system of the BioRobot Universal as 
follows: 

a. Arrange the QF data by column with the following headings: Well, Sample 
Name, Qty, Final Con. 

b. Convert all 0 values to 0.01. 

c. Convert all exponents to decimal. 

d. Round all concentrations to 2 decimal places. 

e. Evaluate the data to determine the appropriate amount of DNA to target for 
amplification and enter this value into the Final Con column. For samples 
with reasonable results, a target of 0.2 ng/μL (acceptable range is 0.03 – 0.4 
ng/μL) may be used in a 12.5 μL amplification and a target of 0.15 ng/μL 
(acceptable range is 0.03 – 0.8 ng/μL) may be used in a 25 μL amplification. 
Note: each sample can have varying concentrations. If varying 
concentrations are used for each sample rather than targeting a particular 
value for the entire plate, save the report generated by the robot 
electronically to include in the case file. 

f. Save the file as a “.csv”.  

g. Include the word “Norm” in the save file (e.g. 07-1 Norm.csv). 

h. Transfer the file to the User Data folder on the BioRobot® computer. 

2. From the QIAsoft™ Software, open the “Normalizaton” protocol and follow the 
directions of the robot: 

a. Enter the name of your file – Be sure to include the .csv extension when 
entering your file name (e.g. 07-1 Norm.csv). 

b. Enter the final volume – this is the final volume for the normalized samples; 
enter at least 30 µL for optimal pipetting. 

c. Enter sample number – this is the total number of samples being 
normalized. Count the standards as samples. 

d. Place a 5 x 80 mL trough with TE on the trough holder. 

e. Fill the tip racks appropriately.  

f. Place your samples in the elution rack with the lid off and the PCR plate 
(normalization plate) in the appropriate location on the robot.  Label the 
normalization plate appropriately. 

g. The robot will run the calculations for normalization of your samples. If an 
error occurs, go back to the .csv file and be sure the values are appropriate. 

3. Once the program is complete, cap and freeze the remaining extracts. 

4. If not immediately using, seal the normalization plate and store in a refrigerator for 
short-term storage or freezer for long-term storage. 
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13.0 QIAGEN BIOROBOT® UNIVERSAL – AMPLIFICATION REACTION 
SETUP 

1. Prepare the master mix for the Identifiler® amplification kit in a 1.7mL tube. 

a. Use the following calculation for 12.5 µL amplification reactions: 

Reaction mix:  5.75 x (# of samples) 
Primer:  2.9 x (# of samples) 
Taq:  0.3 x (# of samples) 

b. Use the following for 25 µL amplification reactions: 

Reaction mix: 11.5 x (# of samples) 
Primer:  5.75 x (# of samples) 
Taq:  0.6 x (# of samples) 

Be sure to vortex and spin each component before use and vortex and spin the master mix after 
preparation. 

2. On the BioRobot® computer select the appropriate amplification setup protocol.  
Follow the protocol instructions on the BioRobot® computer: 

a. Select the Samples Below – a graphic of a 96 well plate is visible; highlight 
by column the number of samples.  

b. The program describes the process. 

c. Follow the instructions for the layout setup for the robot.  

d. Enter the Master Mix volume – for a 12.5 µL amplification, enter 8. For a 25 
µL amplification, enter 15. 

e. Enter template DNA volume per reaction.  

f. Place the normalized samples on the robot. 

g. Place an additional PCR plate on the robot for the amplification.  Label the 
amplification plate appropriately. 

h. Place the 1.7mL tube of amplification master mix in the reagent slot being 
sure to uncap the tube. 

i. Put the appropriate tips on the robot. 

j. If adding TE, select an amount to produce the desired target. 

k. During the run, add TE to the –C well from the trough TE was dispensed 
from during the normalization protocol. 

3. When the run is complete, take the amplification plate to a PCR set-up hood to add 
the positive amplification controls and seal the PCR plate.  Place the plate on the ABI 
GeneAmp® PCR System 9700 thermal cycler. 

a. Select the appropriate program for a 13 or 25 µL amplification on the 9700 
and start the amplification process. 

4. Seal and freeze the remaining normalized samples. 
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14.0 MICROCON® CONCENTRATION OF DNA 
1. Assemble a Microcon® Fast Flow concentrator unit.  To the top of the concentrator, 

add 30-100 µl TE, if desired.  Transfer the DNA extracts to be concentrated to the top 
of the concentrator.  The total volume of extract and TE added to the sample 
reservoir should be no more than 500 µL.   

2. Cap the concentrator and spin in a centrifuge at ~500 to 5000 x g for about 10-15 
minutes or longer (settings can be adjusted according to centrifuge type and sample 
viscosity).    

3. Carefully remove the concentrator unit from the assembly and discard the filtrate fluid 
from the filtrate vial.  Return the concentrator to the top of the filtrate vial. 

4. Add 200 µl TE to the concentrator.  Recap and spin the assembly in the centrifuge for 
~10 minutes at ~500 to 5000 x g. 

NOTE: Additional washes may be required to remove inhibitors that may be 
present and should be done on samples of extremely limited quantity. 

If the microcon is being used to just concentrate or reduce sample volume, the 
addition of TE as a wash step is not necessary. 

5. Remove the cap, if adding TE; add the desired final volume of TE to the concentrator.   

6. Remove the concentrator from the filtrate vial and carefully invert the concentrator 
onto a new labeled retentate vial.  Discard the filtrate vial. 

7. Centrifuge the assembly at 1000 x g for ~5 minutes (or pulse briefly). 

8. Discard the concentrator.  Cap the retentate vial.   

Samples are ready for human DNA quantitation.  Use samples immediately for PCR or refrigerate 
samples for storage while the sample is actively being worked (avoid repeated freeze-thaw cycles).  
Freeze samples for long term storage.  Prior to use for PCR, vortex and pulse spin samples. 

  



Washington State Patrol Crime Laboratory Division 
CODIS Lab STR Procedures Manual 

 

CODIS Lab STR Procedures Page 30 of 87 Revision June 1, 2016 
Approved by CLD Commander All Printed Copies Uncontrolled Revision 22 

 

15.0 ABI 7500 SEQUENCE DETECTION SYSTEM (SDS) INSTRUMENT 
CREATING DETECTORS 

Before creating a plate document, detectors shall be created in the SDS software.  Once the detectors 
are created, this step may be omitted in subsequent runs. 

1. Launch the SDS software and open a new plate document. 

2. Select Tools > Detector Manager. 

3. In the lower left of the Detector Manager dialog box, select File > New to open the 
New Detector dialog box. 

4. Create a detector for the Quantifiler™ Human kit: 

a. Enter Quantifiler™ Human in the Name field. 

b. Select FAM as the Reporter Dye. 

c. Ensure (none) is selected as the Quencher Dye. 

d. Click the Color square to select a color. 

e. Click Create Another to add the Quantifiler™ Human detector and to reset 
the New Detector dialog box. 

5. Create a detector for the IPC assay: 

a. Enter IPC in the Name field. 

b. Select VIC as the Reporter Dye. 

c. Ensure (none) is selected as the Quencher Dye. 

d. Click the Color square to select a color. 

e. Click OK to add the IPC detector and to return to the Detector Manager box. 
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16.0 ABI 7500 SDS INSTRUMENT – PLATE DOCUMENT TEMPLATE 
SETUP 

A plate document template greatly reduces the time required to set up a plate document. Typically, the 
quantification standards and detectors will already be in place in a previously agreed upon layout 
requiring only that the unknown samples and detectors be entered. Additionally, thermal cycler 
conditions and reaction volume settings may be attached to a template. Templates may also be 
created for situations that consistently require a plate document that differs from a day-to-day standard 
plate layout.  

1. Launch the SDS software. 

2. In the SDS software, select File > New to open the New Document dialog box. 

3. The default settings in the dialog box should read Absolute Quantitation (Assay), 96-
Well Clear (Container), and Blank Document (Template). 

4. Apply the desired template settings to the plate document.  This might include any of 
the following: 

a. Apply Detectors to the plate document. 

b. Apply Detectors for standards and for unknown samples. 

c. Input names for the quantification standards. 

d. Set thermal cycler conditions (delete the Stage 1, the 50°C pre-incubation). 

5. Save the plate document as a template. 

a. From the SDS software, select File > Save. 

b. For Save as type, select SDS Templates (*.sdt). 

c. Locate and select the Templates folder within the SDS software folder 
(C:\Program Files\SDS 1.2\Templates).  Enter a template file name.  This 
might be a generic name easily recognizable for subsequent runs or it might 
be a name specific to the plate set up. 

d. Click Save. 

NOTE: Don’t omit wells on the template.  
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17.0 ABI 7500 SEQUENCE DETECTION SYSTEM (SDS) INSTRUMENT 
- CREATING A PLATE DOCUMENT FROM A TEMPLATE 

1. Launch the SDS software. 

2. In the SDS software, select File > New to open the New Document dialog box. 

3. The settings in the dialog box should read Absolute Quantitation (Assay) and 96-Well 
Clear (Container).  For Template, select an appropriate template from the list. If the 
template is not in the list, click Browse to locate the required template (i.e. this may 
also be an Excel template filled out in advance in Excel with the test sample info). 

4. Complete the plate document setup.  This may require any or all of the following 
depending on the information already contained in the template: 

a. Add detectors to the plate document (see ABI 7500 Sequence Detection 
System (SDS) Instrument; Creating Detectors SOP). 

b. Apply detectors for standards and for unknown using the well inspector from 
the view menu. 

c. Enter sample names. 

d. Set Thermal cycler conditions (if present, delete the Stage 1, the 50◦ C pre-
incubation). 

5. Before running the reaction plate, save the plate document as an SDS Document 
(*.sds) file. 

a. From the SDS software, select File > Save. 

b. Select the location for the file. 

c. Enter a file name. 

d. For Save as type, select SDS Documents (*.sds) then click Save. 

NOTE: Don’t omit a well before the data has been collected. 
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18.0 QUANTIFILER® – DNA QUANTIFICATION REACTION 
PREPARATION 

The amount of PCR amplifiable human DNA is determined using the ABI QuantifilerTM Human DNA kit.  
This assay is performed using the ABI 7500 Sequence Detection System (SDS).  

 

Gloves shall be worn when handling kits and kit components. 

1. Calculate the volume of the Quantifiler™ PCR Reaction Mix needed to prepare the 
reaction master mix (5.3 µl per sample and standard).  Calculate the volume of 
Quantifiler™ Human Primer Mix to prepare the reaction master mix (4.5 µl per 
sample and standard). 

2. Thaw the primer mix completely, vortex 3 to 5 seconds and pulse spin briefly before 
opening the tube (thaw one tube from a kit at a time to minimize freeze/thaw cycles.) 

3. Swirl the Quantifiler™ PCR reaction mix gently before using.  Do not vortex.   

4. Pipette the calculated volumes of components into an appropriately sized tube. 

5. Vortex the master mix for 3 to 5 seconds, then pulse spin briefly. 

6. Obtain a 96-well reaction plate and seat in the optical support base.  The reaction 
plate shall not be rested on any surface without the base.  The plate shall not be 
touched on the bottom of the wells. 

7. Dispense 9.2 µl of the master mix into each reaction well of the reaction plate. 

8. Add 0.8 µl of sample, standard, or control to the appropriate well of the reaction plate, 
as determined by the plate setup sheet. 

9. Seal the reaction plate with the Optical Adhesive Cover.  Care shall be taken not to 
touch the adhesive cover.  The plastic applicator shall be used to seal the adhesive 
cover to the reaction plate.  Drag the applicator across the adhesive cover several 
times to ensure a proper seal.  Seal around the edges and remove the white strips on 
the adhesive cover. 

10. Centrifuge the plate as necessary to eliminate bubbles. 

11. Open the ABI 7500 SDS instrument and place the precision holder in the heat block. 

12. Place the 96 well plate in the ABI 7500 with well A1 in the upper left corner.   

13. Push the tray closed. 

14. Follow the QuantifilerTM and ABI 7500 SDS Instrument Data Analysis and 
Interpretation SOP for collecting and analyzing data. 

15. After run is completed, turn off the ABI 7500 SDS instrument at the earliest 
convenience. 
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19.0 QUANTIFILERTM AND ABI 7500 SDS INSTRUMENT DATA 
ANALYSIS AND INTERPRETATION 

The ABI QuantifilerTM Human DNA Quantification Real-Time PCR assays using the ABI 7500 
Sequence Detection System (SDS) is used to determine the amount of PCR amplifiable human DNA.  
The Internal PCR Control (IPC) in the assay monitors for the presence of PCR inhibitors and may 
indicate when it is appropriate to consider additional DNA sample clean up steps. 

1. Launch the ABI SDS software. 

2. Analyze a run after it is complete and reanalyze after you make any changes to the 
plate document (such as sample names). 

3. Open the plate document to analyze. 

a. Verify the analysis settings: 

b. Select Analysis > Analysis Settings to open the Analysis Settings dialog 
box. 

c. Verify the settings are as follows:  Threshold 0.200000, Baseline Start 
(cycle) 6, and Baseline End (cycle) 15. 

d. Select Analysis > Analyze or click the Analyze icon. 

4. View the Standard Curve. 

a. In the Results tab, select the Standard Curve tab. 

b. In the Detector drop-down list, select the Quantifiler™ Human detector.  

c. View the CT values for the quantification standard reactions and the 
calculated regression line, slope, y-intercept, and R2 values.  The CT value 
is the cycle at which the amplification curve crosses the threshold.  The 
lower the CT value, the more DNA detected. 

d. The slope indicates the amplification efficiency; -3.32 is ideal (100% 
efficiency). 

NOTE: The range of acceptable values is determined by the specific 
laboratory’s validation for each instrument.  Typical values are: 

Typical Range: -2.9 to -3.3 

Average Slope: -3.1 

If the slope is outside the determined range then a check of the assay setup, 
software setup, reagents and instrument may be appropriate.  

e. R2 (correlation coefficient) indicates the statistical significance of the 
standard curve.  An R2 value greater than 0.98 is desirable.  If R2 is less 
than 0.98, check the following: 

 Quantity values entered for quantification standards in the Well i.
Inspector during the plate document setup.  

 Preparation of serial dilutions of quantification standards. ii.
 Loading of reactions for quantification standards. iii.
 Failure of reactions containing quantification standards. iv.

f. The standard curve slope should be within the typical range between runs 
(see 4.d. above) or parameters determined by performance testing on 
individual instruments can be used to establish the acceptable range and 
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the R2 equal to or greater than 0.98.  Only one acceptable standard curve is 
required for analysis.  If two duplicate standard curves are run, one of the 
duplicates in a standard sample can be removed from the standard curve if 
it is an outlier.  This may be done for up to two of the standard samples as 
long as there is one sample from the duplicate set that is acceptable.  If one 
of the two duplicate standard curve sample sets is not acceptable, then that 
set may be entirely removed and the remaining acceptable standard curve 
sample set may be used.  These changes shall be documented in the case 
file. 

NOTE: If the standard curve exceeds the observed ranges of slope as 
stated above (4.d.) and the R2 is less than 0.98, the quantification may not 
be optimal and consequently the standard curve may still be used, but only 
to provide limited assistance in making analytical decisions (i.e. 
approximating the dilution to use for the desired target amount of DNA to 
amplify).    

5. View the Amplification Plot. 

a. In the Results tab, select the Amplification Plot tab. 

b. In the Detector drop-down list, select Quantifiler™ Human and IPC. 

c. Select the appropriate samples in the table below the amplification plot. 

d. Ensure the threshold value is set to 0.20, the default setting. 

e. The amplification view displays cycle-to-cycle changes in fluorescence and 
is useful for determining if there is no DNA present or if inhibition is 
preventing the amplification of the DNA.  If the IPC crosses the threshold 
within the range of the standard samples but the sample does not cross the 
threshold, then the amount of DNA in the sample is less than 23 pg/ul with 
no inhibition.  If the IPC and sample do not cross the threshold, PCR 
inhibition is evident and sample clean up should be considered.  If there is a 
weak QuantifilerTM amplification of the sample with no or a reduced 
amplification of the IPC (outside the range of the standard samples) partial 
PCR inhibition is suspected.  Sample clean up and re-quantification may be 
appropriate (see Microcon® Concentration of DNA SOP).  There may be 
cases where there is a very strong amount of DNA present and the IPC 
shows inhibition but a full DNA profile may still be obtained. 

6. View the Report. 

a. The report summarizes the quantity of DNA present in the samples. 

b. In the analyzed plate document, select the Results tab then select the 
Report tab. 

c. Select the reactions in the 96-well plate representation below the report to 
display the results in the report. 

d. View the Qty column to determine the quantity of DNA in each sample.  
Samples with the same name will have their quantity values averaged. 

7. To print or export the report. 

a. In the Report tab of the results window, select Tools > Report Settings, then 
set up how the report is printed and exported.   

b. Select File > Print to print the report. 
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c. Select File > Export to export the report as tab-delimited text that may be 
opened later using spreadsheet software. 

8. A negative sample result may have an amplification plot similar to a very low level 
DNA sample due to background.  Compare plot to a negative well to confirm whether 
or not it is background.  

 

Data for each case file shall be saved as an *.sds file.  The sample info may be omitted and detectors 
removed for samples from other case files run on the same plate. 
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20.0 AMPLIFICATION OF STR LOCI – IDENTIFILER® 25 µL 

1. The following parameters shall be used to program the thermal cycler: 

Activation  95º C  11 min 
Number of cycles: 1 

Denaturation  94º C  1 min 
Annealing  59º C  1 min 
Extension  72º C  1 min 
Number of cycles: 28 

Final extension  60º C  60 min 

Hold   10º C  ∞ 

NOTE: An additional program may be built into the thermal cycler of 60°C for 45 minutes. This 
may be used to re-extend a sample which exhibits a shoulder. If this program is used, it shall 
be documented in the case file and shall also be applied to the reagent blank control. 

2. Prepare the DNA samples to be amplified. Approximately 0.125 to 4.0 ng of template 
DNA may be targeted. Using the DNA quantification results, calculate the volume of 
sample needed to provide the desired amount of DNA to amplify.  

3. Prepare the components from the AmpfℓSTR® Identifiler® PCR amplification kit by 
vortexing and pulse spinning the reaction mix, AmpliTaq Gold®, control DNA, and 
primer set. 

4. Prepare the samples for amplification (the following step shall be performed in the 
dedicated biological PCR amplification hood). 

a. Prepare a master mix.  For each sample, add: 

10.5 µL reaction mix 
5.5 µL primer set 
0.5 µL AmpliTaq Gold® 

b. Vortex the master mix and aliquot 15 µl per PCR reaction tube. 

c. Add 10 µl of TE/DNA mixture (separately or together), control DNA, and/or 
TE buffer to the appropriate tubes. 

5. Load the tubes into the AB GeneAmp® PCR System 9700 thermal cycler and start 
the amplification process.  
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21.0 AMPLIFICATION OF STR LOCI – IDENTIFILER® 12.5 µL 

1. The following parameters shall be used to program the thermal cycler: 

Activation  95º C  11 min 
Number of cycles: 1 

Denaturation 94º C  1 min 
Annealing  59º C  1 min 
Extension  72º C  1 min 
Number of cycles: 28 

Final extension 60º C  60 min 

Hold  10º C  ∞ 

NOTE: An additional program may be built into the thermal cycler of 60°C for 45 minutes. This 
may be used to re-extend a sample which exhibits a shoulder. If this program is used, it shall 
be documented in the case file and shall also be applied to the reagent blank control. 

2. Prepare the DNA samples to be amplified. Approximately 0.063 to 4.0 ng of template 
DNA may be targeted.  Using the DNA quantification results, calculate the volume of 
sample needed to provide the desired amount of DNA to amplify.  

3. Prepare the components from the AmpfℓSTR® Identifiler® PCR amplification kit by 
vortexing and pulse spinning the reaction mix, AmpliTaq Gold®, control DNA, and 
primer set. 

4. Prepare the samples for amplification (the following step shall be performed in the 
dedicated biological PCR amplification hood). 

a. Prepare a master mix.  For each sample, add: 

5.25 µL reaction mix 
2.75 µL primer set 
0.25 µL AmpliTaq Gold® 

b. Vortex the master mix and aliquot 7.5 µl per PCR reaction tube. 

c. Add 5.0 µl of TE/DNA mixture (separately or together), control DNA, and/or 
TE buffer to the appropriate tubes. 

5. Load the tubes into the AB GeneAmp® PCR System 9700 thermal cycler and start 
the amplification process.   
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22.0 AMPLIFICATION PRODUCT PREPARATION FOR THE 3500XL   

1. Prepare a mixture of Hi-Di™ formamide and GeneScan™ 600 LIZ® Size Standard 
v2.0 in a microcentrifuge tube using the following formulas: 

a. (# samples +1) x 8.5 µL formamide 
b. (# sample + 1) x 0.5 µL LIZ 600 
c. Example: 58.8 µL LIZ 600 per 1 mL formamide 

 

NOTE: Formamide is a teratogen. Be sure to wear gloves. 

2. Vortex and spin briefly. Label the tube with the LIZ lot number, the preparer’s initials, 
and the date. 

3. Dispense 9.0 µL of LIZ+formamide mixture into each well of a MicroAmp® reaction 
plate that will be used. Wells that are injected, but contain no PCR product must be 
filled with either LIZ+formamide or formamide. 

4. Add 0.1 – 2.0 µL of PCR product or allelic ladder to each well. PCR product may be 
diluted with TE buffer. 

5. Cover the plate with a septum and spin briefly to remove any bubbles. 

6. Denature samples on a 95°C heat block or thermal cycler for 3 minutes. 

7. Snap-cool samples for 3 minutes. 

8. Place the plate in a plate base and cover with a plate retainer. 
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23.0 RUNNING PLATES ON THE 3500XL GENETIC ANALYZER  

1. On the Dashboard of the 3500 Series Software, click the ‘Start Pre-Heat’ button to 
turn on the oven. 

2. Complete any maintenance that is required. 

3. With the instrument door closed, push the tray button to bring the autosampler 
forward. Place any plates to be run on the autosampler. When the door is shut, the 
autosampler should return to its home position. 

4. Navigate to the Main Workflow portion of the 3500 Series Software to create a new 
plate or import a plate from a template. The following parameters must be applied to 
each plate: 

a. Assay: 5sec, 7sec, 10sec, 15sec, or 24 sec 
b. Results Group: CODIS 
c. File Name Convention: CODIS 

 
5. On the ‘Load Plate for Run’ screen, verify that any plates on the instrument are linked 

correctly and start the run. 

6. Wait until the ‘Monitor Run’ screen is displayed before leaving the instrument. Error 
messages (ex. expired reagent installed, not enough POP-4 remains for all injections, 
etc.) may appear before this screen is displayed; the run will not proceed until the 
messages are acknowledged. 
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24.0 GENEMAPPER® ID-X SETUP 
The following procedure applies to ID-X users with Admin profile access and shall be applied to any 
Server copy of ID-X.    

If an individual user name has not been created, log in as user “gmidx”.  Otherwise, log in using the 
individual user name. Once an Admin profile user has been created, any changes to the software shall 
be done from that profile to maintain a more accurate audit trail record.  

24.1 SETTING UP A USER ACCOUNT 

1. Open Security Manager 

2. Select the appropriate user account type: 
a. For an administrator, select Databasing Tech Lead 
b. For an analyst, select Databasing Analyst 

3. Select Edit > Duplicate 

4. In the name field, change the name to the CODIS login of the individual the account 
applies to. 

5. Enter the full name of the individual under Full Name in the User Details section. 

6. Select Pre-Expire for the password to prompt the new user to create a password 
upon their first login. 

7. Select Set Password and create a generic password for the new user. 

8. Select File > Save 

For custom user groups, user accounts, or security groups, follow the steps as outlined in the 
GeneMapper ID-X Administrator’s Guide. Additional information about editing users can also be found 
in the Administrator’s Guide. Only an Admin level user with the input of the CODIS technical lead 
and/or the DNA Technical Leader may make these changes. 

After any changes are made in the Security Manager, a copy of the settings should be exported as a 
backup. If more than one Server exists, the settings shall be imported to that computer to ensure they 
are the same (see the GeneMapper ID-X Administrator’s Guide for instructions on exporting and 
importing security settings). 

24.2 SETTING UP THE AUDIT TRAIL CONFIGURATION 

 
1. Open the ID-X software 

2. Choose Admin > Audit Manager > Setting 

3. Log in to Audit Manager 

4. Choose “Allele” from the left navigation pane 
a. Set “deleted” and “created” to “on” 
b. Set “modified” to “silent” 

5. Choose “Sample” from the left navigation pane 
a. Set “deleted”, “OverrideSQ”, “modified, and “created” to “off” 
b. Set “OverrideGQ” and “OverrideCGQ” to “silent” 
c. Set “ALLELE” to “on” 

 
24.3 SETTING UP THE ANALYSIS METHOD FOR CONVICTED OFFENDER ANALYSIS 

1. Open GeneMapper ID-X Manager. 
2. Select the Analysis Method tab and click New. 
3. Select the General tab and enter the following: 
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a. Name: ID_3500xL_<implementation date> 
b. Security Group: Databasing Security Group 
c. Instrument: 3500xL 

4. Select the Allele tab and enter the following: 

a. Bin Set: AmpFLSTR_Bins_v3X 
b. Use marker-specific stutter ratio and distance if available: check box 
c. In the Tetra column, change the following: 

 MinusA Ratio: 0.1 i.
 MinusA Distance: From 0.5 to 1.5 ii.

d. Amelogenin Cutoff: 0.0 
5. Select the Peak Detector tab and enter the following: 

a. Ranges: 
 Analysis: Partial Range, 2100 to 10000 iii.
 Sizing: Partial Sizes, 80 to 400 iv.

b. Smoothing and Baselining: Light Smoothing, 51 pts Baseline Winder 
c. Size Calling Method: Local Southern Method 
d. Peak Amplitude Threshold: 150 for all dye colors 
e. Min. Peak Half Width: 2 pts 
f. Polynomial Degree: 3 
g. Peak Window Size: 15 pts 
h. Slope Threshold: start and end at 0.0 
i. Normalization: uncheck the box 

6. Select the Peak Quality tab and enter the following: 
a. Homozygous min peak height: 550.0 
b. Heterozygous min peak height: 150.0 
c. Max Peak Height (MPH): 40000.0 
d. Min peak height ratio: 0.45 
e. Max peak width: 1.5 
f. Max expected alleles: 2 for autosomal/AMEL, 1 for Y markers 
g. Allelic Ladder Spike: Enable detection, Cut-off Value 0.2 
h. Sample Spike Detection: Disable 

7. Do not alter the default settings in the SQ & GQ Settings tab. 
8. Save the analysis method. 

 
24.4 CHANGING THE MARKER SPECIFIC STUTTER RATIOS 

1. Open Panel Manager. 
 

2. Choose AmpFLSTR_Panels_v3X and Identifiler_v1.2X_3500xL 
 

3. Enter the stutter percentages as outlined in the table below: 
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Identifiler Stutter Thresholds 

Locus Minus Stutter Plus Stutter  
D8S1179 8.8% 1.4% 
D21S11 9.4% 2.4% 
D7S820 8.2% 3.1% 
CSF1PO 9.6% 3.1% 
D3S1358 12.0% 2.4% 
TH01 5.1% 0.0% 
D13S317 10.0% 2.6% 
D16S539 10.4% 2.6% 
D2S1338 12.6% 2.9% 
D19S433 14.4% 5.0% 
vWA 12.6% 5.2% 
TPOX 5.4% 0.0% 
D18S51 17.0% 5.2% 
D5S818 10.0% 1.6% 
FGA 14.7% 4.3% 

 

4. Click Apply and close Panel Manager. 

24.5 SETTING UP PROJECT OPTIONS 

1. From the Project Window, go to File > Project Options. 

2. Select the General tab and choose the following: 

a. Under Project, check Open Blank Project 

b. Under Data Access Control, select Databasing Security Group 

3. Select the Add Samples tab and choose the following: 

a. Set Analysis Method to: Current Analysis Method 

b. Set Size Standard to:  GS600_LIZ+Normalization_(80-400)  

c. Set Panel to:  Identifiler_v1.2X_3500xL 

4. Select the Analysis tab and choose the following: 

a. Under Analysis Summary check: 

 Stop analysis and display Analysis Requirements Summary i.
 Stop analysis and display Allelic Ladder Analysis Summary ii.
 View Analysis Summary iii.

b. Under Quality Metrics Display, check Symbols 

5. Click OK to save the Project Options. 

24.6 IMPORTING LAB REFERENCE AND CUSTOM CONTROL PROFILES 

1. From the Project Window, open the run folder containing the desired profile 

2. Go to the Samples tab and ensure the Sample Name is the desired custom name for 
the reference or control 

3. Select the sample and go to Tools > Add Profile > Lab Reference (in the case of a 
reference) or Custom Control (in the case of a control) 
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4. Click Close in the Add Profile Results dialogue box to save the profile 

24.7 ESTABLISH SOURCE AND DESTINATION LABS FOR CODIS FILES 

1. Go to Tools > CODIS Export Manager  

2. Under Source Lab IDs, enter the source lab and select add  

3. Under Destination Lab IDs, enter the destination lab and select add  

4. Click OK   
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25.0 GUIDELINES FOR MANUALLY EVALUATING CONVICTED 
OFFENDER DNA TYPING PROFILES 

The following guidelines are provided for evaluating convicted offender DNA typing profiles obtained 
by STR analysis using the AB AmpFℓSTR® Identifiler® Amplification Kit, an AB Genetic Analyzer, and 
AB GeneMapper® ID-X software. 

25.1 GENERAL GUIDELINES FOR EVALUATING PROFILES 

1. Raw Data 

a. Typically the primer peak should rise and fall abruptly and the baseline 
should be flat and smooth. In problem samples, if the primer peak trails 
excessively or the baseline is significantly elevated, the sample should be 
re-injected. 

2. True alleles 

a. A true allele is defined as a distinctive, sharp peak that is expected to be 
greater than the analytical threshold (detection threshold) in height, clearly 
visible above baseline noise, and typically having a size estimated between 
100 and 400 bp. Background signals, insufficient resolution, and the 
possibility of allelic drop-out should be considered and could make the 
sample data inconclusive for data below the analytical threshold. 

b. Homozygous alleles are expected to appear as single peaks at least as high 
as the stochastic threshold (550 rfu). 

c. Heterozygous alleles are expected to appear as two peaks at least as high 
as the analytical threshold (150 rfu) and usually have a peak height ratio 
greater than 45 percent. 

 When interpreting alleles just above the analytical threshold, allelic i.
drop-out should be considered. 

 Should a peak height imbalance be less than 45%, the sample shall ii.
be re-injected for confirmation. The Amelogenin locus is an 
exception to this re-injection requirement. If a peak height imbalance 
less than 45% persists, the analyst, in conjunction with the reviewer, 
can determine if the imbalance is acceptable.  Otherwise, the sample 
shall be re-amplified.  
 

d. If an off-ladder allele is observed, the allele may be accepted without 
additional analysis if the size quality of the sample is passing and the variant 
allele has been previously observed. Otherwise, any off-ladder allele will be 
confirmed by a second injection to ensure the sample ran correctly.  

 If the variant allele has not been previously reported, re-extract the i.
sample to confirm the result. If a re-extraction is being performed, a 
second injection is not required for confirmation of the variant allele. 
The NIST STRBase site http://www.cstl.nist.gov/div831/strbase can 
be checked for non-published variant allele reports to see if the allele 
has been encountered previously.  

 The following table should be used as a guide for outside the ladder ii.
allele designations. 
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D8S1179 <8 >18 
D21S11 <24.2 >38 
D7S820 <6 >14 
CSF1PO <6 >15 
D3S1358 <12 >19 
TH01 <5 >10 
D13S317 <8 >15 
D16S539 <5 >15 
D2S1338 <15 >28 
D19S433 <9 >17.2 
vWA <11 >21 
TPOX <6 >13 
D18S51 <9 >26 
D5S818 <7 >16 
FGA <18 >30 

 
 For off-ladder alleles above or below the limits listed in the table that iii.

are given an “OL” designation by ID-X, the applicable > or < will be 
used as the allele designation. 

 For manual CODIS tables, the lower and upper values as outlined in iv.
the table above must be used. 
 

e. If a tri-allele is observed and has been previously reported at the NIST 
STRBase site, it will be confirmed by a second injection.  If the tri-allele has 
not been reported, the sample will be re-extracted for confirmation.  A 
second injection is not required in this case. 

f. Abnormal sex chromosome variants (e.g. XXY) do not need to be re-tested. 

g. If a one base pair difference between two alleles cannot be resolved using 
typical methods like re-injection or re-amplification, the Polynomial Degree 
and Peak Window Size in the ID-X analysis method may be adjusted.  This 
will be documented in the case file and the modified analysis method should 
be included in the electronic data. 

25.2 ANTICIPATED PCR ARTIFACTS 

If an artifact can be confidently characterized as one of the following anomalies, the sample does 
not need to be re-injected. If there is uncertainty about an anomalous peak, the sample should be 
re-run to ensure quality and accuracy of allele calls. Those anomalous peaks that are labeled by 
GeneMapper® ID-X as either an allele or artifact must be given the correct label so as to not be 
mistakenly entered as a true allele in CODIS. The appropriate designation for each artifact is 
listed under that artifact’s description below. 

1. Spikes 

a. Spikes have a general appearance of being needle-like and are randomly 
seen in samples. Spikes typically disappear with re-injection. Commonly, 
spikes are observed in most or all of the dye colors, and generally at the 
same base pair location. Occasionally, single color spikes may also be 
observed. The heights of spikes (in rfu) usually vary between dye colors.  

b. If a spike is given a designation by GeneMapper® ID-X, the analyst must 
ensure it is an artifact designation and that it is labeled: spike. 

c. It is permissible for an analyst to override the Genotype Quality of a marker 
for spikes. 
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2. Pull-Up 

a. Pull-up artifacts are peaks that show up at the same base pair size or within 
a base pair equivalent on either side of the true allele, but in another color. 
Pull-up usually occurs under peaks with excessive signal or under strong 
alleles.  

b. For instances where pull-up is given an inappropriate designation by the 
software, the analyst must ensure the artifact label indicates: pull-up.  

c. It is permissible for an analyst to override the Genotype Quality of a marker 
for pull-up. 

3. N-4 Stutter Peaks  

a. These peaks are normally one repeat smaller than the true allele peak. 
Threshold values (% of true allele) for considering peaks as n-4 stutter are:  

 

  Identifiler n-4 Stutter Thresholds 

Locus Minus Stutter 
D8S1179 8.8% 
D21S11 9.4% 
D7S820 8.2% 
CSF1PO 9.6% 
D3S1358 12.0% 
TH01 5.1% 
D13S317 10.0% 
D16S539 10.4% 
D2S1338 12.6% 
D19S433 14.4% 
vWA 12.6% 
TPOX 5.4% 
D18S51 17.0% 
D5S818 10.0% 
FGA 14.7% 

 

b. The analyst, in combination with the reviewer, can determine if a minimal 
deviation in stutter percentage is acceptable. Should stutter exceed the 
threshold greater than a minimum deviation, it will be evaluated jointly with 
the CODIS technical lead or DNA Technical Leader to determine if the 
potential of a weak heterozygote or tri-allele exists. Otherwise, the sample 
will be re-amplified. If the peak persists and is not noted on STRBase, the 
sample will be re-extracted.  

c. For acceptable elevated stutter peaks that are given a designation by 
GeneMapper® ID-X, use the artifact designation elevated stutter. 

d. It is appropriate for an analyst to override the Genotype Quality for a marker 
exhibiting elevated stutter if the conditions in 3.b are met. 

4. N+4 Stutter Peaks 

a. These peaks are usually one repeat larger than the parent peak. Threshold 
values (% of true allele) for considering peaks as n+4 stutter are: 
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Locus  Validated Plus Stutter Percentage°  
D8S1179  1.4%  
D21S11  2.4%  
D7S820  3.1%  
CSF1PO  3.1%  
D3S1358 2.4%  

TH01  0.0%  
D13S317 2.6%  
D16S539  2.6%  
D2S1338  2.9%  
D19S433  5.0%  

vWA  5.2%  
TPOX  0.0%  

D18S51  5.2%  
D5S818 1.6%  

FGA  4.3%  
◦ Taken from the WSPCCL n+4 study. 

 

b. N+4 can be observed at percentages higher than this amount and should be 
interpreted with caution. When in doubt, an analyst shall re-amplify the 
sample in a 25 µL amplification reaction for confirmation. If uncertainty still 
exists, the CODIS technical lead or DNA Technical Leader must be 
consulted. 

c. For acceptable elevated n+4 peaks that are given a designation by 
GeneMapper® ID-X, use the artifact designation elevated stutter. 

d.  It is appropriate for an analyst to override the Genotype Quality for a 
marker with an n+4 peak provided the conditions of 4b are met. 

5. Shoulders 

a. Shoulders flank the sides (one or both) of a true allele.  

b. If the shoulders are given a designation in GeneMapper® ID-X, the sample 
shall be extended, re-run at a shorter injection time, or re-amplified using 
less template DNA. This requirement does not apply to the Amelogenin 
locus or to shoulders 10% or less of the allele. 

c. It is not appropriate for an analyst to override the Genotype Quality for a 
marker with shoulders (with the exception of Amelogenin and shoulders 
10% or less of the allele). 

6. Formamide/Dye Blobs 

a. Raised baseline areas may represent formamide/dye blobs which usually 
occur at the same base pair location in multiple samples of the run.  

b. An analyst must ensure a dye blob given an artifact or allele designation by 
GeneMapper® ID-X has an artifact designation of: dye blob. 

c. It is appropriate for an analyst to override the Genotype Quality for a marker 
with a dye blob. 

NOTE: When there is any uncertainty about an anomalous peak, the sample must be re-run to 
ensure quality and accuracy of the allele calls. 
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25.3 QUALITY FLAGS 

Quality flags will be triggered if a sample does not meet the pre-set requirements or user-defined 
requirements for the software. Below is a list of potential flags and the conditions under which 
they could be overridden by an analyst. 

1. Sample-level Quality Assessment 

a. SOS – Sample Off-scale 

 May be overridden if any anomalies observed do not affect the i.
quality of the genotyping result. 

b. SQ – Sizing Quality 

 The sample may be accepted if the genotype of the sample and i.
quality of the data is unaffected, but the flag should not be 
overridden until the technical reviewer also evaluates the sample. 

c. MIX – Mixed Source 

 May be overridden if the sample is confirmed as a tri-allele or i.
chimera. 

 May be overridden if the analyst determines the flag was thrown due ii.
to the software designating artifacts as alleles 

d. OMR – Outside Marker Range 

 May be overridden once the microvariant is confirmed. It is important i.
that the analyst assigns the allele to the appropriate locus. 

 May be overridden if the peak is determined to be an artifact by the ii.
analyst 

e. SSPK – Sample Spike 

 May be overridden in samples and controls. i.
 May not be overridden in ladders. ii.

f. CGQ – Composite Genotype Quality 

 May only be overridden by a peer reviewer as confirmation of i.
agreeing with the analyst’s changes to the sample. 

 May not be overridden for ladders. ii.

2. Marker-level Quality Assessment 

a. OS – Off-Scale 

 May be overridden if any anomalies observed do not affect the i.
quality of the genotyping result. 

b. BIN – Out of Bin Allele 

 May be overridden if the peak is a microvariant allele or an anomaly i.
that has been confirmed. 

c. PHR – Peak Height Ratio 

 May be overridden once it has been confirmed or if the flag was i.
thrown due to an artifact being labeled as an allele or OL.  PHR in 
controls do not have to be verified, provided the genotype is correct. 

d. MPH – Max Peak Height 
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i. May be overridden if any anomalies observed do not affect the quality of 
the genotyping result. 

e. LPH – Low Peak Height 

 May not be overridden for true alleles i.

f. AN – Allele Number 

 May be overridden in the case of confirmed tri-alleles, no X in i.
Amelogenin (if it is confirmed to not be present), or if the software 
threw the flag due to artifacts and the analyst evaluated them as 
such. 

 May not be overridden under any other circumstance. ii.

g. BD – Broad Peak 

 May be overridden if the sample is free from OL designations and i.
the positive controls in the run folder genotyped correctly. 

h. CC – Control Concordance 

 May not be overridden unless the software threw the flag due to i.
artifacts and the analyst evaluated them as such. 

i. SPK – Marker Spike 

 May be overridden in samples but not ladders. i.

j. OVL – Overlapping Alleles  

 May be overridden if the allele can be confirmed or in the case of a i.
known artifact. 

25.4 START A NEW PROJECT 

1. Start with a blank project in the Project Window. 

2. Click the Add Samples to Project Icon. 

3. Navigate to the location of the desired run folder, then click Add to List. 

4. Click Add. 

5. Select the desired table view under Table Setting. 

6. Ensure the appropriate Sample Type, Analysis Method, Panel, and Size Standard 
are selected. 

7. If a laboratory positive control was used in the run folder, select it from the drop down 
menu under Custom Control. 

8. Click the green arrow to analyze the samples. 

9. In the Save Project dialogue box enter the following: 

a. Name: the project name 

b. Security Group: Databasing Security Group 

c. Click OK 

25.5 EVALUATION OF LADDERS AND CONTROLS 

1. Select the Analysis Summary tab. 

2. Review all passing ladders.  Any failed ladders must be evaluated by an analyst to 
verify the failure wasn’t due to a factor that affected the corresponding injection. 
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3. From the Analysis Summary tab, evaluate the passing positive, negative, and custom 
controls. For failed controls, an analyst may override a flag that has been triggered 
depending on the type of anomaly.  

a. Reagent Blank 

 No forensically significant PCR product should be detected in the i.
reagent blank sample. See the contamination flow chart for a reagent 
blank in Appendix II of the DNA Quality Manual should contamination 
be suspected. 

 The reagent blank must be injected at least as long as the ii.
corresponding samples. 

b. Internal Laboratory Control (Custom Control) 

 When used, the internal laboratory control (ILC) should yield the i.
correct allele designations and be free of forensically significant 
contamination. See the contamination flow chart for a sample in 
Appendix II of the DNA Quality Manual should contamination be 
suspected. 

c. Positive Amplification Control 

 The positive amplification control (+C: DNA from the female cell line i.
9947A) should yield the correct allele designations and be free of 
forensically significant contamination. See the contamination flow 
chart for a sample in Appendix II of the DNA Quality Manual should 
contamination be suspected. 

 Because multiple instances of the positive amplification control could ii.
exist on a plate, at least one should pass.  

d. Negative Amplification Control 

 No forensically significant PCR product should be detected in the i.
negative amplification control (-C). See the contamination flow chart 
in Appendix II of the DNA Quality Manual for a negative amplification 
control should contamination be suspected. 

 The –C must be injected at least as long as the corresponding +C. ii.

25.6 EVALUATION OF SAMPLES 

An analyst must evaluate all samples in a run folder. An analyst may choose to view passing 
samples separately from samples that did not meet all of the thresholds or an analyst may view 
all samples together. To view all samples together, select the number under Total # of Samples. 
To view samples where all thresholds were met, select that number, and to view samples where 
one or more thresholds were not met, click that number. Work flow is up to the analyst as long as 
all samples are evaluated. 

1. Highlight a sample and select Display Plots. 

2. Evaluate the sample to verify allele designations and that the profile is free from 
anomalies or contamination. 

a. If more than two true allele peaks occur at multiple loci (two or more), then 
the profile should be considered as having originated from more than one 
individual. Occasionally, three alleles may be detected at any one locus. If 
there is no other indication of more than one source for the DNA it is 
permissible to assume a single source and accept the genotype result for 
CODIS after the appropriate confirmations are made. 
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b. If contamination is suspected, refer to Appendix II of the DNA Quality 
Manual for the appropriate troubleshooting steps. 

3. For samples that were flagged by GeneMapper® ID-X, select the locus with the flag 
and evaluate the description of the flag in the Quality Value Details box.  

a. If the flag is something an analyst can override, make the appropriate change 
and “Override the Genotype Quality” at that marker. Appropriate overrides 
are discussed previously in this section. 

 Continue evaluating other flags in the marker; override those that are i.
appropriate to override. 

 When prompted to override the Composite Genotype Quality, select ii.
No.  

 Evaluate the remaining non-flagged loci to ensure there are no iii.
anomalies or evidence of contamination and that the analyst agrees 
with the allele calls. 

b. If a flag is not appropriate to be overridden, continued evaluation of the 
sample is unnecessary except in terms of troubleshooting what steps (in the 
laboratory or otherwise) to take next with that sample. 

c. For all analyst-evaluated passing samples, change the Export Type to the 
appropriate designation. 

4. Repeat the process for the remaining samples in the project. 

25.7 CODIS DATABASE 

Profiles deemed appropriate to enter into the state CODIS database and/or NDIS must be peer 
reviewed prior to entry. Refer to the WSP CLD CODIS Manual for further guidelines on entering 
convicted offender sample profiles into the state CODIS database and NDIS. 

If a sample is appropriate for NDIS or SDIS, make an electronic or manual CODIS table (as 
appropriate) for that sample. 

1. For electronic tables: 

a. Select the Export Type in the column next to the sample. 

b. When all appropriate samples to be exported have been selected, choose 
File > Export Table for CODIS. 

c. Ensure the appropriate destination and source laboratories are selected and 
that the file type is CMF 3.2 (.xml). 

d. The file name for the CODIS table should be the same as the run folder 
name. 

e. Choose the appropriate location to save the table and click Export. 

2. For manual tables: 

a. Make a manual table in Microsoft Excel being sure to include all loci and 
reported alleles. 

b. For weak samples, single alleles above the analytical threshold and below 
the stochastic threshold will be in parenthesis. These alleles will not be 
entered into CODIS, but may be used for exclusion or evaluating matches. 
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26.0 GUIDELINES FOR EVALUATING CONVICTED OFFENDER DNA 
TYPING PROFILES USING GENEMAPPER® ID-X V1.4 AS AN 
EXPERT SYSTEM 

26.1 EVALUATION OF SAMPLES USING ID-X AS AN EXPERT SYSTEM 

This procedure shall be followed to optimize workflow and expedite data analysis when using 
GeneMapper ID-X as an Expert System. 

26.1.1 Evaluating Ladders and Controls 

1. From the Analysis Summary tab:  

a.  Any passing allelic ladders do not have to be evaluated. 

b. Failed allelic ladders must be evaluated by an analyst to verify the failure 
wasn’t due to a factor that affected the corresponding injection. 

c. In the case of more than one of the same kind of control (i.e. amplification 
positive controls that were amplified at the same time on the same thermal 
cycler), only one iteration need pass. If there is not a positive control under 
the “All Thresholds Met” column, view the positive control(s) under the “One 
or more thresholds not met” column and evaluate why they did not pass. 
Follow the guidelines already described in this manual for evaluation of 
positive controls. 

d. Select the negative controls and verify no trace contamination exists.  

26.1.2 Evaluating Samples 

An analyst is only required to view samples under the “One or more thresholds not met” column. 
To maximize workflow, an analyst should not view samples under the “All Thresholds Met” 
column for routine data analysis. 

1. If the project contains samples to be uploaded to CODIS, select the number of the 
samples under the “All Thresholds Met” column under the “Analysis Summary” tab. 
Change the “Export Type” of all samples in this column to the appropriate 
designation. Otherwise, proceed to the next step. 

2. From the “Analysis Summary” tab, select the number of the samples under the “One 
or more thresholds not met” column. 

3. Highlight a sample and display the plot. Use a plot setting that allows for the “Quality 
Value Details” box to be visible. 

4. Select the first locus with a flag and evaluate the description of the flag in the “Quality 
Value Details” box. 

5. If the flag is something an analyst can override: 

a. Make the appropriate change and “Override the Genotype Quality” at that 
marker. Appropriate overrides are discussed previously in this manual.  

b. Continue evaluating other flags in the sample; override those that are 
appropriate to override. 

c. When prompted to override the “Composite Genotype Quality”, select No. 

d. Evaluate the remaining non-flagged loci to ensure there are no anomalies or 
evidence of contamination and that the analyst agrees with the allele calls. 
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6. If a flag is not appropriate to be overridden, continued evaluation of the sample is 
unnecessary except in terms of troubleshooting what steps (in the laboratory or 
otherwise) to take next with that sample. 

7. If more than two true allele peaks occur at multiple loci (two or more), the profile 
should be considered as having originated from more than one individual. 
Occasionally, three alleles may be detected at any one locus. If there is no other 
indication of more than one source for the DNA profile, it is permissible to assume a 
single source and accept the genotype result for CODIS after the appropriate 
confirmations are made.  

e. If contamination is suspected, refer to Appendix II of the DNA Quality Manual 
for the appropriate troubleshooting steps. 

8. If an analyst overrode the flags to pass the sample, change the Export Type to the 
appropriate designation. 

Repeat the process for the remaining samples in the “One or more thresholds not met” column. 

26.1.3 CODIS Tables 

If manual CODIS tables need to be prepared, make those prior to technical review, print the table 
and include it in the case file. 
 
For electronic CODIS tables, export any samples for CODIS after the technical reviewer has 
evaluated the run folder. When exporting samples for CODIS tables, select an unfiltered view of 
the project to ensure inclusion of all exportable samples. 

http://sharepoint/sites/flsb1/CLD/DNA/Manuals/DNA_QA_Manual_Rev_20.pdf
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27.0 CODIS CASE FILE CONTENT 

A CODIS Case File consists of all documentation related to CODIS Casework including hard copy and 
electronic data and/or worksheets.  A CODIS Case File will contain, at minimum, the following items 
filled out with sufficient information as to appropriately record all of the pertinent data. 

27.1 CODIS CASE FILES 

1. Extraction Worksheet (for any manual extractions) 

2. 7500 Load Sheet (for any manual 7500 runs) 

3. Amplification Worksheet (for any manual amplification set-ups) 

4. Robot Worksheet (for any robot sets) 

5. Run Folder Review Sheet 

6. CE Loading & Reagent Worksheet (if applicable) 

7. Manual CODIS Table (when appropriate) 

8. CODIS Table (when appropriate) 

9. PDF of the puncher work list (when appropriate) 

10. Quantifiler™ Projects  

11. Normalization File (when appropriate) and Normalization Report (when appropriate) 

12. Raw Data folder(s) containing only those samples and controls related to a particular 
set 

13. The GeneMapper® ID-X project(s) for any data that was reported (exported with 
analysis settings) 

14. The peer review checklist (to be added by the technical reviewer) 
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28.0 MANUAL CODIS CASE FILE REVIEW WITH GENEMAPPER® ID-X 
V1.4 

There are two fundamental steps to the review of CODIS case files which are to be performed by a 
qualified CODIS scientist:   

1. Review of the electronic data.  

2. Review of the associated paperwork from extraction through analysis to verify 
documentation is accurate.  

It is the responsibility of the reviewer to ensure the analyzed data is as accurate and complete as 
possible. At minimum the following will be done:  

1. Verify that all electronic documents and files are present. 

2. Check the GeneMapper® ID-X results.  

a. The ladders and quality control samples will be evaluated by the reviewer to 
ensure they meet the requirements as described in the Guidelines for 
Evaluating DNA Typing Profiles using GMID-X section of this manual. 

b. The reviewer must look at all samples (to include the ILS) reported from a 
run folder. 

 For samples where a flag was overridden or an edit was made, the i.
reviewer must evaluate the changes.  

 When an edit has been made, the reviewer must ensure the original ii.
analyst documented the change appropriately in the GMID-X 
software. 

 If the reviewer agrees with the edited profile and/or the analyst’s iii.
assessment to override flags, the reviewer indicates this by 
overriding the Composite Genotype Quality (CGQ) of the sample. 

 For passing samples, the reviewer will evaluate the profiles for allele iv.
designations and that the sample is free from extraneous peaks. 

 
c. All samples shall meet the requirements outlined in the Guidelines for 

Evaluating DNA Typing Profiles using GMID-X section of this manual. In 
instances where they do not, but there is cause to report the sample, the 
CODIS Technical Lead or DNA Technical Leader may sign off on those 
samples if it is viewed as appropriate. This must be reflected in the case file. 

d. The CODIS tables will be evaluated to ensure the samples are reported 
from the correct run folder, the table is the correct export version, each 
sample has the appropriate Export Type, and that the analyst’s CODIS 
username is correct. 

3. Review the paper worksheets.  

a. Check that all information is filled out on the worksheets and that the 
appropriate worksheets are present.  

b. Check that the case numbers of the convicted offender samples are 
accurate across all worksheets.  

c. Verify that a set number, date, and initials are on each page. 

d. Ensure that all strikeouts and additions are initialed.  
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For a more detailed list of what is required for the technical review of a CODIS Case File, see the 
CODIS technical review worksheet. 
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29.0 CODIS CASE FILE REVIEW WITH GENEMAPPER® ID-X V1.4 AS 
AN EXPERT SYSTEM 

29.1 TECHNICAL REVIEW OF GENEMAPPER ID-X AS AN EXPERT SYSTEM 

Open the first project in GeneMapper ID-X. 

29.1.1 Review of ladders 

Ladders do not have to be evaluated by a technical reviewer.  

29.1.2 Review of controls  

The ILS of a control under the “All Thresholds Met” column does not have to be reviewed by the 
technical reviewer. 

From the Analysis Summary tab: 

1. Check the negative controls under the “All Thresholds Met” column for trace 
contamination. 

2. Do not look at the other controls under the “All Thresholds Met” column. 

3. If any controls are under the “One or more thresholds not met” column, click on the 
number under the total number of controls in that column. 

4. Look at any control reported from the project to verify analyst overrides are 
appropriate. 

5. For any control with allele edits, use the “View Allele Edits” plot setting to verify 
artifacts/alleles are documented appropriately. 

6. If in agreement with the control overrides/edits, override the CGQ of the control. 

7. For projects with more than one positive amplification control from the same 
amplification, only one of those controls must pass. 

29.1.3 Review of samples 

The ILS of a sample under the “All Thresholds Met” column does not have to be reviewed by the 
technical reviewer. 

1. Do not view the genotypes of samples under the “All Thresholds Met” column. 

2. Click on the number under the “One or more thresholds not met” column. 

3. Look at any sample reported from the project to verify analyst overrides are 
appropriate. 

4. For any sample with allele edits, use the “View Allele Edits” plot setting to verify 
artifacts/alleles are documented appropriately. 

5. If in agreement with the sample overrides/edits, override the CGQ of the sample. 

6. Continue for all reported samples from the run folder. 

Continue reviewing the case file and other projects, if applicable. 

For confirmation runs, it is appropriate to review the original iteration of the sample to verify an 
appropriate confirmation was made. 

Review the electronic CODIS tables to ensure the appropriate samples are reported from the 
correct run folder with the correct Export Type, export version, and analyst CODIS username. 
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For additional details on the requirements of technical review, see the CODIS Peer Review 
Checklist.  

  

http://sharepoint/sites/flsb1/CLD/CODIS/Forms%20%20Templates/Forms/AllItems.aspx
http://sharepoint/sites/flsb1/CLD/CODIS/Forms%20%20Templates/Forms/AllItems.aspx


Washington State Patrol – Crime Laboratory Division 
CODIS STR Procedures Manual 

 

CODIS Lab STR Procedures Page 60 of 87 Revision June 1, 2016 
Approved by CLD Commander All Printed Copies Uncontrolled Revision 22 

 

30.0 TEMPGENIUS™ WIRELESS DATA ACQUISITION & MONITORING 
SYSTEM  

The TempGenius system is used to wirelessly record the temperature for refrigerators, freezers, and 
ovens in the lab. Rather than recording the temperature of a unit at one time of day, TempGenius 
constantly monitors and records the temperature. If a unit falls outside of the desired temperature 
range, TempGenius will alert the user and record the event. This allows for more effective monitoring 
of refrigerators, freezers, and ovens.  

30.1 GENERAL INSTALLATION AND OPERATION 

Refer to the TempGenius “Installation Guide And Operating Manual”. 

30.2 ALERTS AND RESOLUTIONS  

TempGenius automatically monitors temperatures and sends alerts to the assigned user(s) and 
TempGenius Dashboard. In addition to viewing temperatures on the Dashboard, real-time 
temperatures may be viewed remotely by accessing the IP address of the TempGenius Data 
Server. Refer to the TempGenius Installation Guide and Operating Manual for instructions on 
alerts and alert resolutions. 

30.3 TROUBLESHOOTING ALERTS 

Use the following table as a guide for troubleshooting alerts. 

Alert 
Type 

Critical 
Unit? 

Action Address Off-
hours? 

Level 1 No If more than two days in a row, verify reading 
against a NIST thermometer. If NIST is within 
allowable range, contact the TempGenius rep, 
otherwise troubleshoot until a solution is 
reached. 

No 

Level 1 Yes If more than two days in a row, verify 
temperature reading against a NIST 
thermometer. If NIST is within the allowable 
range, contact the TempGenius rep, otherwise 
move contents of unit to another location until a 
solution can be reached. 

No 

Level 2 No Verify reading against a NIST thermometer. If 
NIST is within allowable range, contact the 
TempGenius rep, otherwise troubleshoot until a 
solution is reached. 

No 

Level 2 Yes Verify the temperature reading against a NIST 
thermometer. If NIST is within the allowable 
range, contact the TempGenius rep, otherwise 
move contents of unit to another location until a 
solution can be reached. 

Yes, if a 
volunteer is 
unavailable, 
notify CODIS 
Manager 

Level 3 No Verify the temperature reading against a NIST 
thermometer. If NIST is within the allowable 
range, contact the TempGenius rep, otherwise 
troubleshoot as needed. 

No 

Level 3 Yes Verify the temperature reading against a NIST 
thermometer. If NIST is within the allowable 
range, contact the TempGenius rep, otherwise 
move contents of unit to another location until a 
solution can be reached. 

Yes, if a 
volunteer is 
unavailable, 
notify CODIS 
Manager 
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31.0 REAGENT PREPARATION 

Use reagent grade chemicals unless otherwise noted.  Pre-made, reagent grade chemicals can be 
substituted for many of the recipes below.  Prepare all solutions using deionized water (dH2O).  Wear 
gloves and follow safety recommendations provided by manufacturer for handling chemicals.  Comply 
with any and all laws, regulations, or orders with respect to the disposal of any hazardous or toxic 
chemical, material, substance or waste.  Reagents that are used solely for the preparation of other 
reagents do not need to be sterilized before making up the new reagent if that reagent will be 
sterilized.  Store all reagents at room temperature unless otherwise noted.  Reagents will be labeled 
with the reagent name, lot number, expiration date (if any), preparer’s initials, and date of preparation.  
Reagents are prepared as follows: 

31.1 0.5M EDTA (1 L) 

Warning:  EDTA is an irritant.  Wear lab coat, gloves, mask, and protective eyewear when 
handling EDTA. 

Warning:  NaOH is corrosive and toxic.  Wear lab coat, gloves, and protective eyewear.  Use 
caution when handling.  NaOH, when combined with water, results in an exothermic reaction. 
Dissolve the NaOH pellets in the water gradually with 3 or 4 additions.  Cover and allow the 
NaOH to dissolve completely and cool between each addition. 

Add 186.1 g of disodium ethylenediaminetetraacetic acid dihydrate (Na2EDTA ⋅ 2H2O) to 800 ml 
of dH2O.  Stir vigorously with a magnetic stirrer.  To dissolve the EDTA powder, adjust the pH to 
8.0 (+/- 0.2) by adding approximately 20 g of NaOH pellets.  Check the pH and add 5N or 10N 
NaOH solution if needed.  Adjust volume to 1 liter with dH2O and mix thoroughly.  The solution 
should be autoclaved or filtered through a sterile 0.2 µm filter. 

31.2 TE BUFFER [10 MM TRIS-HCL, 0.1 MM EDTA, PH 8.0 (1 L)] 

Add 10 ml of 1 M Tris-HCl, pH 8.0 and 0.2 ml of 0.5 M EDTA to 990 ml dH2O and mix thoroughly.  
Autoclave. 

31.3 1 M TRIS-HCL, PH 8.0 (1 L) 

Dissolve 98 g Tris-HCl and 46 g Tris base in 800 ml of dH2O.  Check that the pH of the solution is 
8.0 (+/- 0.2).  Adjust final volume to 1 liter with dH2O and mix thoroughly.  Sterilize by autoclaving. 

31.4 1 M DITHIOTHREITOL (DTT - 10 ML) 

Add 1.542 g of DTT to 10 ml dH2O.  Aliquot 1 ml of solution to ten tubes.  Store frozen. 

31.5 LYSIS BUFFER + DTT 

Prepare Lysis Buffer + DTT by mixing 1 ml of 1.0 M DTT for every 100 ml DNA IQ™ Lysis Buffer. 
Mix by inverting several times.  Store at room temperature. 

31.6 1X WASH BUFFER 

Prepare 1X Wash Buffer by mixing one part 95-100% ethanol, one part isopropyl alcohol, and two 
parts DNA IQ™ 2X Wash Buffer. Mix by inverting several times.  Store at room temperature. 

31.7 QUANTIFILER™ QUANTIFICATION STANDARDS 

DNA quantitation standards are critical for accurate analysis of run data.  Any mistakes or 
inaccuracies in making the dilutions directly affect the quality of the results.  Great care shall be 
taken when measuring and mixing dilutions.   

1. Prepare the DNA Quantitation Standards using G147A (Promega catalog #G1471) 
genomic DNA (SRM 2372 traceable) 

2. Label eight disposable tubes to be used for the dilution series. 

3. Prepare the TE with glycogen by adding 1µl glycogen to 1 ml of TE.  Vortex. 
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4. Dispense the required amount of TE/glycogen to each tube.  (See note* on next page 
to adjust for lot to lot variation in stock DNA standard.)  

5. Prepare the standards using the following table. 

a. For standard 1: 

 Briefly vortex the G147A Human DNA Standard and pulse spin. i.
 Using a new pipette tip, add the calculated amount of G147A Human ii.

DNA Standard to the tube for Standard 1. 
 Vortex and pulse spin the dilution iii.

b. For standards 2 through 8: 

 Using a new pipette tip, add the calculated amount of the previously i.
prepared standard to the tube for the next standard. 

 Vortex and pulse spin the standard. ii.
 Repeat steps d.2.i and d.2.ii until the dilution series is completed. iii.

6. The prepared Human DNA Standards may be stored for up to 4 weeks at 2 to 8ºC.   

 
Standard Concentration 

(ng/ul) 
Example Amounts Minimum Amounts† Dilution 

Factor 
*Std. 1 50.000 50 µl [200 ng/µl stock*] + 

150 ul TE/glycogen buffer 
10 µl [200 ng/ul stock] + 30 µl 
TE/glycogen buffer 

4X 

Std. 2 16.700 50 µl [Std. 1] + 100 µl 
TE/glycogen buffer 

10 µl [Std. 1] + 20 µl 
TE/glycogen buffer 

3X 

Std. 3 5.560 50 µl [Std. 2] + 100 µl 
TE/glycogen buffer 

10 µl [Std. 2] + 20 µl 
TE/glycogen buffer 

3X 

Std. 4 1.850 50 µl [Std. 3] + 100 µl 
TE/glycogen buffer 

10 µl [Std. 3] + 20 µl 
TE/glycogen buffer 

3X 

Std. 5 0.620 50 µl [Std. 4] + 100 µl 
TE/glycogen buffer 

10 µl [Std. 4] + 20 µl 
TE/glycogen buffer 

3X 

Std. 6 0.210 50 µl [Std. 5] + 100 µl 
TE/glycogen buffer 

10 µl [Std. 5] + 20 µl 
TE/glycogen buffer 

3X 

Std. 7 0.068 50 µl [Std. 6] + 100 µl 
TE/glycogen buffer 

10 µl [Std. 6] + 20 µl 
TE/glycogen buffer 

3X 

Std. 8 0.023 50 µl [Std. 7] + 100 µl 
TE/glycogen buffer 

10 µl [Std. 7] + 20 µl 
TE/glycogen buffer 

3X 

† To ensure the accuracy of pipetting, the minimum input volume of DNA for dilutions is 10 µl. 
 

*NOTE:  How to adjust for lot to lot variation in the Human DNA Standard: 

Use the SRM 2372 kit from NIST to determine the DNA concentration of each new lot of G147A 
DNA standard.  For step 1 of preparing the Quantitation Standard sets, dilute the stock according 
to the actual concentration obtained for the new lot of DNA.  The rest of the dilution steps remain 
the same. 

31.8 DISPENSING HI-DI FORMAMIDE 

Hi-Di Formamide is harmful if swallowed, inhaled, or absorbed through the skin. See MSDS for 
full disclaimer. When aliquoting Hi-Di Formamide, work in a fume hood with gloves and lab coat.  

Remove the Hi-Di bottle from the freezer and allow it to come to room temperature until contents 
have thawed. Aliquot 1 mL Hi-Di into 1.5 mL autoclaved tubes. Label each tube with the lot, date 
of dispensing, and initials. Freeze immediately. 
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31.9 REAGENT EXPIRATION DATES 

The following table lists expiration dates for reagents used in the CODIS Laboratory. Reagents 
that are tested before each use do not require an expiration date. Should a stock solution 
purchased from a distributor be used rather than being made in the lab, the expiration date on the 
bottle overrides any expiration date listed here. 

Commercially prepared critical reagents that do not have an expiration date assigned by the 
manufacturer will be assigned one by the laboratory based on performance testing and review of 
scientific literature or up to three years from receipt. 

Non-critical commercially prepared reagents that do not have an expiration date assigned by the 
manufacturer do not need one assigned by the laboratory provided they are stored and 
maintained appropriately.  The integrity of these reagents, as with any reagent, will be monitored 
at the time of use. 

 
Reagent Expiration Dates 
DTT 3 years (stored frozen) 
0.5 M EDTA 3 years 
TE Buffer 2 years 
1M Tris-HCl 3 years 
Lysis Buffer + DTT 1 month 
1X Wash Buffer 1 year 
QF Standards 4 weeks if in glycogen 
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32.0 TEMPGENIUS™ WIRELESS DATA ACQUISITION & MONITORING 
SYSTEM MAINTENANCE 

32.1 SEMIANNUALLY 

A NIST probe reading for each monitored unit will be recorded semiannually, to ensure the 
accuracy of the temperature readings recorded by TempGenius.  If the difference between the 
TempGenius reading and the NIST reading is outside the allowable range, another reading will be 
taken at a different time. In the event that the TempGenius reading is once more outside the 
range, contact the manufacturer. 

 
For Daylight Savings time changes, a “write setup” from the Pointware program to the data 
receiver must be performed to sync the computer and device time. Before performing the write 
setup, ensure that the historical data collections are current. This can be done my making sure 
the time of “last contact” listed in Pointware (under the Point Managers tab) is the same as the 
current time on the computer. 
 
Once the historical data are current, perform the write setup in Pointware via the Point Managers 
tab. 

1. Right-click on the appropriate Point Manager name 
2. Select “Push” 
3. Select “Write Setup” 
4. Select “Yes”. 
 
 

32.2 ANNUALLY 

Calibration of sensors – see the TempGenius “Installation Guide and Operating Manual” 

The manufacturer defines the annual calibration as the adjustment (or replacement) of a sensor 
due to temperature variability against a NIST probe.  The average offset for a sensor will be 
determined based on the total readings for the year.  The laboratory may choose to make an 
adjustment if the offset between the sensor and NIST probe is +/-1°C.  If the average offset of a 
sensor is more/less than +/- 4°C, an adjustment is mandatory and the manufacturer will be 
contacted. 

If any adjustment is made to the sensor, a reading with A NIST probe will be taken the following 
day to verify the adjustment.  All adjustments will be documented on the TempGenius 
maintenance sheet. 

32.3 EVERY 30 MONTHS OR AS NEEDED  

Replace the batteries (Type AA, 3.6V) in the sensors by unscrewing the transmitter cover. 
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33.0 UV IRRADIATOR OPERATING INSTRUCTIONS 
33.1 OPERATION  

1. Turn the power on. The digital display should read 0000 or 0; if it does not, press 
reset.  

2. Place the consumables in an orientation to allow maximum exposure. 

3. Select the Energy button. The number on the display represents microjoules/cm2 x 
100.   

• For autoclaved consumables, set the microjoule level to 500,000 μJ/cm2. 
• For non-autoclavable consumables, set the microjoule level to 999,900 μJ/cm2 

4. If an error is made in entering, press the reset button to clear the display.  

5. Press start to begin irradiation.   

 
33.2 MAINTENANCE  

1. Clean the floor of the UV Irradiator with a soft cloth and nonabrasive cleaner once a 
week.  

2. Change bulbs as needed.  
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34.0 WALLAC DBS PUNCHER; INSTRUMENT MAINTENANCE 
34.1 WEEKLY 

1. Clean the instrument cover and plate area 

a. Clean the instrument cover and plate area with a soft cloth or Kimwipe® 
tissue that has been sprayed with a mild detergent solution or alcohol. 

b. Clean the plate area with an anti-static device. 

34.2 ANNUALLY 

Instrument maintenance can be performed by a qualified Perkin Elmer representative or by the 
University of Washington’s Scientific Instruments Service Center. 

34.3 AS NEEDED 

1. Replace the puncher piston and punch counter 

a. The puncher piston and punch counter should be replaced after 400,000 
punches.   

b. The punch count can be determined through the display menu under 
configuration. 

c. Replace the piston and reset the counter following manufacturer’s operating 
manual. This can be included as part of the manufacturer’s scheduled 
service maintenance.  
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35.0 QIAGEN BIOROBOT UNIVERSAL MAINTENANCE 

When a maintenance procedure is due, the “Run” icon in the Execute Environment will be yellow. 
Selecting the Maintenance Environment will allow the user to view the current maintenance 
procedures that are due and all maintenance procedures available.  Detailed instructions are provided 
for each procedure in the Maintenance Environment. 

Because the BioRobot Universals are not necessarily used on a daily basis, maintenance protocols 
that are due on a more frequent basis than the robot is used will be run before each use rather than by 
time. The exception to this is the Preventive maintenance procedure that is conducted by a qualified 
technician. 

Certain maintenance procedures listed in the BioRobot Universal Manual are for features of the robot 
not used by the CODIS Laboratory. Those maintenance procedures are not required. 

  

35.1 DAILY MAINTENANCE PROCEDURES 

Perform the following daily maintenance procedures: 

1. Liquid containers 

2. Tip-disposal station 

3. Worktable 

35.2 WEEKLY MAINTENANCE PROCEDURES 

Perform the following weekly maintenance procedure: 

1. Reagent carousel 

35.3 MONTHLY MAINTENANCE PROCEDURES 

The weekly and daily maintenance will be completed before starting any monthly maintenance. 

Perform the following monthly maintenance procedures: 

1. System liquid container 

2. High-speed dispensing system and liquid detectors 

3. Worktable 

4. Robotic handling system 

35.4 BIANNUAL MAINTENANCE 

1. Check the dilutor system 

a. From the Execute Environment, select Syringe Calibration Check UNIV from 
the protocol selection box and click Run. Follow the wizard instructions. 

b. If the dilutor system needs to be calibrated, select Syringe Calibration Adjust 
UNIV from the protocol selection box and click Run. Follow the wizard 
instructions. 

35.5 ANNUAL MAINTENANCE 

Annual preventive maintenance is performed by a qualified technician and includes a check of the 
dilutor system. 
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36.0 BIOTEK PLATE READER – INSTRUMENT MAINTENANCE 
36.1 BEFORE USE: 

1. Turn off and disconnect the instrument from the power supply. 

2. Moisten a clean cotton cloth with water or with water and a mild detergent – do not 
soak cloth. 

3. Wipe the plate carrier and all exposed surfaces of the instrument. 

4. If detergent was used, wipe all surfaces with a cloth moistened with water. 

5. Use a clean, dry cloth to dry all wet surfaces. 

36.2 MONTHLY 

1. Run the Absorbance Plate Test 

a. Follow the procedure for the Absorbance Plate Test as outlined in the 
BioTek plate reader user manual. 

36.3 SEMI-ANNUALLY 

1. Run Liquid Test 1  

a. Follow the procedure for Liquid Test 1 as outlined in the BioTek Plate reader 
user manual. 

36.4 AS NEEDED: 

1. Replace the bulb 

a. Follow the procedure for bulb replacement as outlined in the BioTek Plate 
reader user manual. 

36.5 ANNUALLY: 

1. The Absorbance Test Plate shall be sent out for re-certification. 
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37.0 ABI 7500 – INSTRUMENT MAINTENANCE 

See the ABI 7500 Instrument Maintenance manual for specific instructions: 

37.1 ON A MONTHLY BASIS: 

1. Check sample block for contamination 

2. Perform a background calibration 

3. Monitor the lamp status 

4. Perform a Function-Test 

37.2 SEMI-ANNUALLY 

1. Perform an Optical calibration 

2. Perform an ROI calibration 

3. Perform a Pure Dye Spectra calibration 

37.3 IF THE INSTRUMENT IS MOVED TO A NEW LABORATORY LOCATION, THE FOLLOWING 
SHALL BE PERFORMED: 

1. ROI calibration 

2. Pure Dye Spectra calibration 

37.4 ON AN AS-NEEDED BASIS OR DURING SCHEDULED DATA ARCHIVAL, THE FOLLOWING 
SHALL BE PERFORMED: 

1. Back up files 

2. Run disk cleanup 

3. Clean sample wells 

4. Replace instrument fuses 

5. Replace the halogen bulb 

6. The RNase P verification plate may be run as necessary for troubleshooting 
purposes. 

NOTE:  The RNase P plate is one time use only; other maintenance plates are re-useable until 
the plate warps. 

After approximately 2000 hours of use, the bulb shall be replaced.  When the bulb is replaced, the 
following shall be performed: 

1. Calibrate the ROI 

2. Run a background calibration 

3. Perform an Optical Calibration 

4. Run the Pure Dye calibration 

5. Verify the Instrument Performance 

If a hardware problem is suspected, a Function Test may be run for troubleshooting purposes.  A 
record of the checks shall be kept in each instrument log.  Retention of the monthly maintenance 
shall be for a minimum of one (1) accreditation cycle. 

When a new 7500 instrument is installed, a performance verification plan addressing sensitivity 
and precision will be drafted and submitted to the DNA Technical Leader for approval.  The 
results of the performance test will be summarized and retained in the instrument log book. 
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38.0 9700 THERMAL CYCLER – INSTRUMENT MAINTENANCE 
38.1 BIANNUALLY 

Consult with the manufacturer’s recommendations when running the following tests: 

Run the Calibration Verification Test 

Run the Temperature Non-Uniformity Test Overview  

38.2 AS NEEDED 

Send to Instrument Services for external calibration 

  



Washington State Patrol – Crime Laboratory Division 
CODIS STR Procedures Manual 

 

CODIS Lab STR Procedures Page 71 of 87 Revision June 1, 2016 
Approved by CLD Commander All Printed Copies Uncontrolled Revision 22 

 

39.0 3500XL GENETIC ANALYZER MAINTENANCE 

 
Spatial Calibration 
A spatial calibration must be performed every time a capillary array is removed or replaced, the detector 
door is opened, or the instrument is moved. 
 

1. In the Maintenance navigation pane, select ‘Spatial Calibration’. 
 

2. Select either ‘Fill’ or ‘No Fill’, then start the calibration. 
 

3. Evaluate the calibration results to ensure that there is: 
a. A sharp peak for each capillary (small shoulders are acceptable). 
b. A ‘+’ marker at the apex of each peak and no off-apex markers. 
c. An even peak profile (all peak about the same height). 

 
4. Accept the results if the criteria above are met. Refer to the 3500xL User Guide if the calibration 

fails. 
 
Spectral Calibration 
Perform a spectral calibration when a new dye set/polymer combination is used, if a new capillary array is 
installed, after any service on the optics, or if there is an increase in pull-up observed. 
 

1. Briefly vortex and spin the DS-33 Spectral Standard. Prepare a solution by mixing 3 µL DS-33 
with 297 µL Hi-Di Formamide. The standard may be diluted more if the peaks are too saturated. 
 

2. Load 10 µL of the standard solution into columns 1 – 3 of a plate. These columns MUST be used. 
Cover the plate with a septum and briefly spin to remove any bubbles. 
 

3. Denature samples on a 95°C heat block or thermal cycler for 5 minutes, then snap-cool for 3 
minutes. 

 
4. Place the assembled plate onto the instrument. Select ‘Spectral Calibration’ in the Maintenance 

navigation pane and verify the calibration settings. 
a. The software will automatically run up to 3 injections to obtain a passing calibration. 
b. Not allowing capillary borrowing generally produces better results, but the software may 

be configured to allow up to 3 borrowing events. 
 

5. Start the calibration. 
 

6. Evaluate the results and choose ‘Accept’ or ‘Reject’. Refer to the 3500xL User Guide for detailed 
instructions on evaluating calibration data. 

 
Maintenance 
The 3500 Series Software employs wizards to assist the user in performing maintenance procedures. 
Access the appropriate wizard from the Maintenance Wizard screen and follow the prompts to complete 
any required tasks. The Maintenance calendar on the Dashboard may also be used to remind users when 
task are due. 
 
Before each run 

• Check for any bubbles in the pump block and lines. If present, use the Remove Bubble Wizard. 
• Check consumables on the Dashboard. Replace polymer and buffers if needed. 

 
Weekly 

• Restart the instrument and computer. 
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• Clean the anode buffer container valve pin. 
 
Monthly 

• Run the Wash Pump and Channels wizard and flush the pump trap. 
• Replace the cathode buffer container septa. 
• Clean the autosampler and drip tray. 

 
Quarterly 

• Run the HID install standard performance check (refer to the 3500xL User Guide). 
 

Annually 
• Preventive maintenance will be performed by a qualified technician. 

 
As needed 

• Replace the capillary array using the Install Capillary Array wizard when poor precision or allele 
calling is noted, or when resolution or signal intensity decreases. Arrays may be used past the 
manufacturer’s expiration date. 

• Perform spectral or spatial calibrations (see sections above). 
• If the instrument will not be in use for more than 2 weeks, refer to the 3500xL User Guide for 

further information on proper care of the instrument. 
 
Performance Checks 
A performance check will be done on an instrument if it has been moved and following repair or routine 
maintenance done by a qualified technician. The check must be completed prior to use for convicted 
offender sample analysis and consists of successfully running: 

1. A ladder, a negative amplification control, and a positive amplification control (or other known 
sample) and 

2. If the sensitivity of the instrument may have been affected (e.g. the optics were adjusted), the HID 
install standard performance check 

 
For new instruments, a 1 base pair precision check with at least 6 ladders run per capillary is required in 
addition to the performance check detailed above. 
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40.0 MAINTENANCE PROCEDURES – GENEMAPPER® ID-X V1.4 
SERVER VERSION ONLY 

40.1 WEEKLY 

1. Exit the software and re-start the computer 

2. Review the statistics for the database (see the GeneMapper ID-X Administrator’s 
Guide for the full procedure) 

40.2 QUARTERLY 

Run calibration samples according to the NDIS Procedures for Expert Systems 

40.3 AS NEEDED 

1. Review password policies 

2. If using the audit system, review 

3. If using the electronic signature system, review 

4. Manage user accounts 

5. Manage security groups 

6. Manage profiles 

7. Back up security settings after making changes 

8. Back up and delete audit trail records when records are close to or exceed 40,000 
records. 
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41.0 TUTTNAUER TABLETOP AUTOCLAVE – INSTRUMENT 
MAINTENANCE 

41.1 PRIOR TO USE 

1.  Fill the water reservoir 

a. Remove the water reservoir cover.   

b. Pour deionized water into the reservoir, through the opening on the top of 
the autoclave until it reaches the base of the safety valve holder 
(approximately 3 liters). 

41.2 WEEKLY 

1. Clean the door gasket  

a. Clean the door gasket with a mild detergent, water and a soft cloth or 
sponge.  The gasket should be clean and smooth. 

41.3 MONTHLY 

1. Change the water in the water reservoir 

a. Ensure that the electrical cord is disconnected and there is no pressure in 
the autoclave. 

b. To drain the reservoir, turn the drain valve counter clockwise to the open 
position.  Place a bucket underneath to catch the flow of water.  Fully drain 
the reservoir. 

c. With a quart of tap water flush out the reservoir.   

d. Turn the drain valve clockwise to the closed position and fill the reservoir 
with deionized water to just below the safety valve.  Plug the electrical cord 
in. 

2. Clean the water sensor 

a. Wipe the sides and tip of the water sensor (located in the rear of the 
chamber) with a mild soapy solution. 

b. It is very important the sides of the sensor are wiped clean. 

41.4 QUARTERLY 

1. Clean the air jet 

a. Remove the water reservoir cover. 

b. Clean the hole of the jet by manipulating the air trap wire back and forth ten 
(10) times. 

c. It is preferred that the cleaning is done while the unit is running a cycle and 
under pressure, but it can also be done while the unit is idle. 

2. Clean and descale the chamber, copper tubes, and reservoir using ChamberBriteTM  

Follow the procedure for cleaning the autoclave as outlined in the  
Tuttnauer Tabletop Autoclave maintenance manual. 
 

3. Clean the trays and tray holder 
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a. Clean the tray holder and trays with detergent or non-abrasive stainless 
steel cleaner and water.   

b. Rinse immediately to avoid staining the metal. 

41.5 AS NEEDED (SEE PROCEDURES AS OUTLINED IN THE TUTTNAUER TABLETOP 
AUTOCLAVE MAINTENANCE MANUAL) 

1. Clean and check the safety valve 

2. Replace the door gasket 

3. Clean the fan grid with compressed air from the inside outward 

4. Clean the strainer 

5. Inspect the locking device for wear 
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42.0 APPENDIX A ADMINISTRATIVE PROCEDURES FOR 
PROCESSING OFFENDER SAMPLES  

42.1 RECEIVING SAMPLES 

42.1.1 Blood samples: 

1. Check that the information on the data submission sheet is complete and matches 
that on the blood vial. Fill out “Received By” and “Date and Time Rec’d” sections. 

2. See the Processing of Convicted Offender Samples section of this manual for more 
information about how blood samples are received and stored. 

42.1.2 Buccal samples: 

1. Group sample envelopes by date received. 

1. Group sample envelopes by submitting agency.  If there is not a return address, 
group by postmark and open to determine agency.  If there is no postmark, open 
envelope to determine agency. 

2. Group sample envelopes by initials on the security seal. 

a. If the seal is absent or tampered with, set the sample aside. 

b. If the initials are absent, open envelope to verify that collector information is 
filled out.  If not, set the sample aside. 

3. Open envelopes one at a time keeping the groups together.  Verify:   

a. Offender information is filled out correctly, and a Washington State 
Identification (SID) Number is present and there is a qualifying offense listed 
on the submission card.  

b. Collector information is complete:  

 Collector’s signature is present. i.

1. If no signature is present, initial and date the “Collector’s Signature” 
field after verifying that the collector has initialed the security seal on 
the envelope. 

2. If neither signature nor initials are present, set the sample aside and 
then call to verify collector. 

 The agency name is present and distinctive. ii.

1. If the agency is not listed or the abbreviation is ambiguous and it can 
be determined from:  the postmark, return address on the envelope or 
group of samples it was submitted with; fill in the appropriate 
information and initial and date the addition. 

 If the collector information cannot be determined, set the sample iii.
aside and call for clarification. 

c. The thumbprints are distinctive and the ridges can be clearly seen. 

d. The DNA sample is obvious on the FTA® paper, i.e. pink paper has turned 
white. 

e. For the multi-component kit, verify the convicted offender’s name, SID 
number (an eight-digit number) and date of birth, if printed on the outer part 
of the FTA® card, corresponds to the information on the submission card. 
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f. If criteria in 4.a-4.e are met, skip to the Assigning Lab Numbers section 
below. 

g. If 4.a is insufficient, look up the missing data on the convicted offender’s 
criminal history or call the collecting agency for clarification.  If an offense is 
determined to be non-qualifying, and the offender does not have a previous 
qualifying conviction, the sample must be rejected. 

4. Agencies that submitted samples that were set aside because of a violation in step 3, 
4.b.i, or 4.c-4.e should be contacted to request a recollection; emphasize that the 
entire kit needs to be redone.  If a recollection is not possible, the sample may be 
accepted at the discretion of a CODIS staff member.   

5. When a sample is rejected, fill out the rejection log with the pertinent information. 

42.1.3 Assigning Lab Numbers 

1. Lab numbers depend upon lab location, the year of submission and the block of 
numbers assigned to the convicted offender program for that year by the CODIS 
Manager. 

a. An example of a lab number assigned to a convicted offender is 103-
015234. 

 The lab number begins with the lab code (Seattle = 1). i.
 The next two digits refer to the year (03 = 2003). ii.
 The remaining six digits are the actual sample number; their start iii.

point is determined by the CODIS manager. Each successive 
sample is assigned the next number in the sequence. 

2. For blood samples, based on the numbering rules above, write the next lab number, 
in sequential order, in the upper right corner of the submission sheet in the box 
labeled “Laboratory No.”/”Crime Lab Use Only”. 

3. The remaining steps are for buccal samples.  Begin with the presorted samples from 
the Receiving Samples section.  

a. For the all-in-one sample card: 

 Number the card with the next available number in the sequence in i.
the box labeled “for Crime Lab Use Only”.  Numbering may be done 
by hand or with pre-printed labels. 

b. For the multi-component kit: 

 Number a 3⅜” x 6” clasp envelope with the next available number in i.
the sequence at the top center of the envelope (the envelope flap 
should be to the left).  Numbering may be done by hand or with pre-
printed labels. 

 Place the FTA card in the envelope. ii.
 Number the corresponding submission card on the front, upper-right iii.

corner of the folded submission card. 

4. Repeat with the remaining samples.  Be sure to keep the numbers in order.  It is 
acceptable to intermix both types of buccal collection kits. 

42.1.4 Entering Data into the Convicted Offender Entry Form 

1. For both blood and buccal samples, open Convicted Offender Entry Form (the user 
name and password are the same as for LIMS). 

2. Make sure Caps Lock is on. 
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3. Select the proper entry type.  When entering an all-in-one sample card, be sure to 
keep the FTA® paper covered.   

a. Washington State Identification numbers (SIDs) are usually eight digits.  
When “SID Number” is selected, the entry field will contain a “WA” prefix. 

b. If a SID number is unavailable, use the “Other Number” type and preface 
the number with one of the following abbreviations: 

 Juvenile numbers are six digits and may be categorized as JUVIS, i.
JRA or JV. 

1. If JUVIS is specified, use JUV. 
2. If JRA is specified, use JRA. 
3. If nothing is specified, but juvenile can be determined by date of birth 

or facility, then use JV. 

c. Social Security numbers should be abbreviated as SSN and entered without 
hyphens or spaces.  Verify with the institution beforehand that this is the 
only ID available. 

d. Department of Corrections numbers should be abbreviated as DOC.  Verify 
with the institution beforehand that this is the only ID available. 

e. Local Identification numbers should be abbreviated as Local ID.  Verify with 
the institution beforehand that this is the only ID available. 

f. Out-of-state Identification numbers should be prefaced with the state’s two 
letter abbreviation.  Verify with the institution beforehand that this is the only 
ID available. 

g. FBI numbers shall be prefaced with FBI.  Verify with the institution 
beforehand that this is the only ID available. 

h. If no number is available indicate “No ID”.  Make all attempts to obtain a 
number from the submitting agency before this step. 

4. Click Enter. 

5. If using entry type 3.a, the “Convicted Offender Sample Entry” dialogue box will 
appear containing the name, date of birth, and DNA status found in W2 for the 
entered SID number. If an error message appears, check the SID to verify that it was 
entered correctly and if it still does not work, set the sample aside to be looked up 
later. 

a. Verify that name and date of birth match the submission card.  Some 
offenders will have multiple names and/or dates of birth; the Convicted 
Offender Program will insert the first listed name or date of birth in W2 into 
the Convicted Offender Entry Form.  For the sake of consistency, if there is 
more than one name and/or date of birth listed in the dialogue box, the first 
one in the list will be assigned to that SID number.  If the submission card 
has an alias name and/or date of birth, note this on the card and write in 
what will be used (date and initial).  If either the name or date of birth on the 
submission card is not listed in the dialogue box, set the sample aside to be 
looked up later. 

b. Check DNA status. 

 If it says “DNA NOT Taken”, Click OK. i.

 If it says “DNA Taken” stamp the following with a “Duplicate” stamp:   ii.
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1. For blood samples, stamp the top of the submission sheet and 
outside of the zip top bag containing the blood sample. 

2. For the all-in-one sample card, stamp the collector information side of 
the card. 

3. For the multi-component kit, stamp the front center of the clasp 
envelope and the upper left corner of the open submission card. 

 Click OK. iii.

c. “Last Name”, “First Name”, “Middle Initial” (if available in W2), “Date of 
Birth”, and “Individual Type” fields will populate automatically. Continue 
entry as follows: 

 Select Gender. i.

 Tab to “Offense Description”.  Enter offense from submission card.  ii.
Common abbreviations are okay. 

 Tab to “Offense Category”.  Select type of offense from drop down iii.
box. 

 Tab to “Collector’s Institution”.  Enter institution from submission iv.
card. 

 Tab to “Collector’s Name”.  Select the representative that did the v.
collection.  If a particular representative is not on the list, they may 
be added by clicking on the green plus (+) button. 

1. Take off the Caps Lock. 
2. Enter collector’s last name, first name, and any other known collector 

information in the available fields. 
3. Type your initials and date added in the “Added by” field. 
4. Click OK. (Make sure Caps Lock is back on). 

 Tab to “Request Date”.  Enter date received. vi.

 Verify appropriate barcode quantity is selected (the default is three).   vii.

1. For blood samples, change this to 0.   
2. For the all-in-one kit, change this to 1.  
3. For the multi-component kit, leave as three. 

 Click OK. (Labels will print after the lab number has been entered.) viii.

 Case ID dialogue box will appear.  Enter Lab Number previously ix.
assigned. 

 Click OK to complete the case entry and print barcode label(s). x.

6. If using entry type 3.b or 3.c, a new entry form will appear (“Individual Type” will be 
automatically set).  Enter first and last name, middle initial, and date of birth.  
Continue as in steps 5.c.i – 5.c.x. 

42.1.5 Affixing Labels  

1. Make sure the number on the label is the same as the number on the Submission 
Card; and for the multi-component kit, on the corresponding envelope. 

2. Place a label on the “CRIME LAB USE ONLY” space on the Submission Card. 

3. For the multi-component kit: 

a. Verify that any information written on the FTA® card matches the 
corresponding Submission Card. 
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b. Place the next label on the outer cover of the corresponding FTA® card.  Do 
not cover any convicted offender information that may be written on the flap; 
instead place the label on the back. 

c. Place the last label over the number already present on the outside of the 
clasp envelope. 

d. Place the FTA® and Submission Cards into the envelope. 

4. File the sample in numerical order in the filing cabinet.   

42.1.6 Administrative Errors 

Error Description Correction 

Duplication of a 
case number 

A particular case number is 
assigned to more than one 
sample. 

LIMS will not allow duplicate entries of a case number. Upon discovery of 
such a duplicate, merely assign the next available case number to the 
submission card and sample envelope (initial if making a strikeout). 

Mis-entering a 
case number 

A case number is entered 
into the Convicted Offender 
form in the wrong format 
(e.g. 406-123456 or 1061-
23456). 

E-mail the LIMS Administrator with a request to delete the incorrect 
number.  
Wait for a response that the incorrect number was deleted from LIMS 
(otherwise a duplicate entry will be created). 
Ensure that the DNA Taken flag has been changed to no (unless the 
sample was already a duplicate). 
Re-enter the sample information with the correct number. 
Print and affix new labels. 

Missing FTA 
card 

An FTA card is not included 
with its corresponding 
submission card. 

Set the card and envelope aside until the correct pairing can be 
established. If a match cannot be made, a request will be made of the 
agency to obtain another sample. Set the card/sample aside until the 
mismatch is ameliorated. 

Switched FTA 
cards 

An FTA card is incorrectly 
paired with a submission 
card. 

Set the card and envelope aside until the correct pairing can be 
established. If a match cannot be made, a request may need to be made 
of the agency to obtain another sample. Set the card/sample aside until 
the mismatch is ameliorated. 

Skipped case 
number 

A case number is omitted in 
the sequence (e.g. 106-
123456  106-123458), 
usually discovered by 
browsing stored submission 
cards. 

Ensure that the missing number has not previously been assigned to a 
card that may have been removed from storage. 
Assign a new card & sample with the skipped case number. 
This should only be done for samples received in the same year. 

Entering the 
wrong request 
date 

The incorrect 
request/receipt date was 
entered into the Convicted 
Offender entry program. 

Wait for the date to be updated in LIMS (usually a day after entry), then 
manually make the correction. Print and affix new labels. 

Mislabeling 
A submission card and/or 
sample envelope is labeled 
incorrectly. 

If possible, remove the incorrect label(s) and determine to which 
card/envelope they belong. Affix to the appropriate card/envelope 
(reprint, if necessary, to maintain adhesive.) 
Print and affix the correct label(s) to the initial card/sample. 
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44.0 WORKSHEETS 
44.1 CODIS CASE FILE FORMS 

The worksheets approved for use in CODIS Casework can be found on the WSP Portal.   
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